Notice

**CS Imaging** is a trademark of Carestream Dental LLC.
All other trademarks and registered trademarks are the property of their respective holders.
Current Dental Terminology (CDT) © American Dental Association (ADA). All rights reserved.

U.S. Federal law restricts this device to sale by or on the order of a dentist or physician.

**CS Imaging** is digital imaging software intended to be used with Carestream Dental's digital imaging devices by healthcare professionals to display, adjust, make measurement, print, export and store digital or digitized images to support image diagnosis in medical care, predominantly in dentistry.

The names of persons and the data reflected in this guide are fictitious and are not intended to represent any real individual, event, or condition. Any resemblance or similarity of the names of persons or data reflected in this guide to any actual person's name or any event or condition is purely coincidental and unintended.

No part of this guide may be reproduced without the express permission of Carestream Dental LLC.

Radiographic images are not intended for diagnostic use when viewed on displays or monitors that do not meet system specifications. For more information, see the **CS Imaging** system requirements.

**Manual Name:** **CS Imaging 8 User Guide**  
Part Number: SMA23  
Edition: 02  
Print Date: 2018-06  
This document is originally written in English.

## Contents

<table>
<thead>
<tr>
<th>Chapter 1</th>
<th>Conventions in This Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Conventions in this Guide</td>
</tr>
<tr>
<td></td>
<td>Important User Information</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 2</th>
<th>Overview</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Before you use CS Imaging</td>
</tr>
<tr>
<td></td>
<td>Viewing 3D Volumes</td>
</tr>
<tr>
<td></td>
<td>Viewing 3D Mesh Objects</td>
</tr>
<tr>
<td></td>
<td>Patient Browser and Dashboard Overview</td>
</tr>
<tr>
<td></td>
<td>Image Viewing Workspace Overview</td>
</tr>
<tr>
<td></td>
<td>Darkroom Mode Overview</td>
</tr>
<tr>
<td></td>
<td>Acquiring an Image Using the Acquisition Toolbar</td>
</tr>
<tr>
<td></td>
<td>Using Icon Groups</td>
</tr>
<tr>
<td></td>
<td>Keyboard Shortcuts in Icon Groups</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 3</th>
<th>Using the Patient Browser and Dashboard</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Patient Browser and Dashboard Workflow</td>
</tr>
<tr>
<td></td>
<td>Icons Available in the Patient Browser and Dashboard</td>
</tr>
<tr>
<td></td>
<td>Overlays Available in Patient Browser and Dashboard</td>
</tr>
<tr>
<td></td>
<td>Using CS Imaging when the DPMS is Unavailable</td>
</tr>
<tr>
<td></td>
<td>Working with Patient Data in Standalone Mode</td>
</tr>
<tr>
<td></td>
<td>Creating a Patient Card</td>
</tr>
<tr>
<td></td>
<td>Adding a Picture to a Patient Card</td>
</tr>
<tr>
<td></td>
<td>Sorting the Patient List</td>
</tr>
<tr>
<td></td>
<td>Searching for a Patient in the Patient List</td>
</tr>
<tr>
<td></td>
<td>Deleting a Patient Card</td>
</tr>
<tr>
<td></td>
<td>Viewing a Patient Card</td>
</tr>
<tr>
<td></td>
<td>Modifying a Patient Card</td>
</tr>
<tr>
<td></td>
<td>Using the Dental Arch Filter</td>
</tr>
<tr>
<td></td>
<td>Selecting Images</td>
</tr>
<tr>
<td></td>
<td>Viewing an Image in the Image Viewing Workspace</td>
</tr>
<tr>
<td></td>
<td>Viewing Images and Other Objects in the Patient History</td>
</tr>
<tr>
<td></td>
<td>Adding a Comment to an Image</td>
</tr>
<tr>
<td></td>
<td>Reassigning Images and Other Objects to a Different Patient</td>
</tr>
<tr>
<td></td>
<td>Deleting Images</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 4</th>
<th>Using the Image Viewing Workspace</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Overview of the Image Title Bar</td>
</tr>
<tr>
<td></td>
<td>Using the Screen Options</td>
</tr>
<tr>
<td></td>
<td>Arranging Images</td>
</tr>
<tr>
<td></td>
<td>Using Auto-Arrange</td>
</tr>
<tr>
<td></td>
<td>Manually Arranging Images</td>
</tr>
</tbody>
</table>
Chapter 5
Using the Darkroom Mode

Tools available in the Darkroom Mode
Overview of the Image Title Bar
Zooming in and out Using the Localization Tool
Using the Screen Options
Exiting the Darkroom mode

Chapter 6
Working with Images

Using the Toolbars in the Image Viewing Workspace or Darkroom Mode
Using the Drawings & Annotations Toolbar
Using the Image Toolbar
Using the Share Toolbar
Viewing Images in Slide Show Mode
Using the Image Gallery
3D Implant View
Saving Images in the Image Viewing Workspace or Darkroom Mode
Deleting an Image
System-Generated Image Overlays
Understanding the Dosimeter Indicator
Displaying Image Information in Overlays
Enhancing Images to Aid Diagnosis
Using the Alt Key to Adjust Image Properties
Using the Control Panel
Using the Image Processing Tool
    Adjusting Image Brightness, Contrast and Gamma in 2D Images
    Modifying Opacity Settings in the 3D View Screen
Adjusting Color Images
    Using the Sharpness Filter
    Images using Pre-Defined Anatomical Mode Filters
    Images using CS Adapt Library Favorites
Using the Histogram
    Using the Transfer Function in a Histogram
    Using Optiview in a Histogram
    Using the Dental Arch Indicator in the Image Viewing Workspace
Drawings, Measurements, and Annotations
    Drawing a Straight Line
<table>
<thead>
<tr>
<th>Chapter 8</th>
<th>General Imaging Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the FMS Editor</td>
<td>88</td>
</tr>
<tr>
<td>FMS Editor Toolbar Buttons</td>
<td>88</td>
</tr>
<tr>
<td>FMS Toolbox Buttons</td>
<td>88</td>
</tr>
<tr>
<td>Creating a Template in the FMS Editor</td>
<td>89</td>
</tr>
<tr>
<td>Customizing an Existing FMS Template</td>
<td>90</td>
</tr>
<tr>
<td>Inserting an Image Frame</td>
<td>91</td>
</tr>
<tr>
<td>Inserting a Preview Frame</td>
<td>91</td>
</tr>
<tr>
<td>Using the Axes to Orient Images</td>
<td>92</td>
</tr>
<tr>
<td>Aligning a Frame</td>
<td>93</td>
</tr>
<tr>
<td>Assigning Default Tooth Numbers</td>
<td>94</td>
</tr>
<tr>
<td>Assigning or Modifying Acquisition Order in an FMS Template</td>
<td>95</td>
</tr>
<tr>
<td>Deleting an FMS Template</td>
<td>95</td>
</tr>
<tr>
<td>Locating an Image File</td>
<td>97</td>
</tr>
<tr>
<td>Locating a Patient Directory</td>
<td>98</td>
</tr>
<tr>
<td>Displaying the Image Information Window</td>
<td>98</td>
</tr>
<tr>
<td>Printing Images</td>
<td>99</td>
</tr>
<tr>
<td>Printing 2D and FMS Images</td>
<td>99</td>
</tr>
<tr>
<td>Printing a Single Image</td>
<td>99</td>
</tr>
<tr>
<td>Printing a Collection of 2D and FMS Images</td>
<td>99</td>
</tr>
<tr>
<td>Printing a Snapshot of the Image Viewing Workspace</td>
<td>100</td>
</tr>
<tr>
<td>Using Film Composer</td>
<td>100</td>
</tr>
<tr>
<td>Importing and Exporting Images</td>
<td>100</td>
</tr>
<tr>
<td>Importing Images</td>
<td>101</td>
</tr>
<tr>
<td>Importing DICOM Images</td>
<td>101</td>
</tr>
<tr>
<td>Exporting Images</td>
<td>102</td>
</tr>
<tr>
<td>Exporting Images to a Folder or an Email</td>
<td>103</td>
</tr>
<tr>
<td>Exporting DICOMDIR</td>
<td>105</td>
</tr>
<tr>
<td>Exporting 3D Images Using the Volume Converter</td>
<td>106</td>
</tr>
<tr>
<td>Using Drag and Drop to Import and Export Images</td>
<td>106</td>
</tr>
<tr>
<td>Importing images using Drag and Drop</td>
<td>107</td>
</tr>
<tr>
<td>Exporting Images using Drag and Drop</td>
<td>107</td>
</tr>
<tr>
<td>Using the Radiological Log</td>
<td>109</td>
</tr>
<tr>
<td>Information Recorded in the Radiological Log</td>
<td>109</td>
</tr>
<tr>
<td>Dose information (present in the image)</td>
<td>109</td>
</tr>
<tr>
<td>Acquisition data (image does not contain dose)</td>
<td>109</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 9</th>
<th>Setting Preferences in CS Imaging</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Preferences</td>
<td>112</td>
</tr>
<tr>
<td>Imaging Preferences</td>
<td>113</td>
</tr>
<tr>
<td>3D View Preferences</td>
<td>114</td>
</tr>
<tr>
<td>Save Preferences</td>
<td>115</td>
</tr>
<tr>
<td>Image Processing Preferences</td>
<td>115</td>
</tr>
<tr>
<td>RVG Processing Preferences</td>
<td>116</td>
</tr>
</tbody>
</table>
1 Conventions in This Guide

Conventions in this Guide

The following special messages emphasize information or indicate potential risk to personnel or equipment:

**WARNING:** Warns you to avoid injury to yourself or others by following the safety instructions precisely.

**Important:** Alerts you to a condition that might cause problems.

**Note:** Emphasizes important information.

**Tip:** Provides extra information and hints.
Important User Information

WARNING:

- The intended users of CS Imaging are healthcare professionals such as Oral health generalists, specialists and dental operator aides.

- Drawings and measurements made in this software are under your own responsibility. A radiographic image is a two dimensional image of a three dimensional object, and measurements may be subject to errors. Measurements are only informative and operations requiring precise positioning on the patient are under your own responsibility.

- It is recommended that you do measurements or drawings with pre-determined length values only on calibrated images. Doing this on an image with no calibration information requires use of a reference segment of known length.

- Panoramic or OPG images, by their nature, contain distortions due to magnification both vertically and horizontally. Any calibrations on these image types must be seen as rough guides that apply only to the immediate vicinity of the calibration. Inserting objects of pre-determined length such as implant simulators provides approximative information.

- Patient orientation information is not provided for intraoral images, computed radiography (CR) images, cephalometric oblique images or color images. Orientation of these images depends on user manipulation and patient positioning.

- This software is an aid to diagnosis only. You must apply your professional training and judgment before deciding a course of treatment.
Overview

**CS Imaging** is a digital imaging software written for the Microsoft Windows operating system. It is intended to be used with Carestream dental digital imaging devices including:

- Intraoral systems: digital sensor and computed radiography (CR)
- Extraoral systems: panoramic, cephalometric, and 3D
- Intraoral digital video capture devices
- Intraoral scanners

This software allows health care professionals to do the following:

- Create a patient database.
- Store in a patient file 2D images, 3D volumes, mesh objects, and even Microsoft Office documents.
- Display a basic preview of 3D volumes and mesh objects for communication purpose only.
- Display and print 2D images.
- Adjust contrast and brightness, and make indicative measurements (distance, length, angle) in 2D images. See “Enhancing Images to Aid Diagnosis”.

**CS Imaging** can access images acquired in the following CS Imaging software:

- KDIS 6.x
- DIS 6.x
- TW 5.x
- **CS Imaging** version 7.x and 8.x

All previously acquired images retain the same image file format, processing adjustments, comments, tooth numbering, drawings, and annotations.

You can use **CS Imaging** as a standalone software or with a DPMS.

**Before you use CS Imaging**

- Familiarize yourself with basic functions of the software:
  - “Patient Browser and Dashboard Overview”
  - “Image Viewing Workspace Overview”
  - “Darkroom Mode Overview”
  - “Patient Browser and Dashboard Workflow”
  - “Acquiring an Image Using the Acquisition Toolbar”
  - “Using the Toolbars in the Image Viewing Workspace or Darkroom Mode”
Viewing 3D Volumes

In **CS Imaging**, you can view volumes generated by **CS 3D Imaging** that contain for example:

- One or more 3D volumes in axial slice view that you can scroll through.
- One or more 3D rendered views that you can rotate, as well as the following predefined orientations:
  - Extracted slices that you can navigate through.
  - Snapshots
  - Pseudo-panoramic images
  - Pseudo Ceph images

**Note:** You cannot use the **Drawings & Annotations** or **Image** toolbars, and in the **Share** toolbar, you can import and export volumes. See “Using the Share Toolbar”.

To view 3D volumes in **CS Imaging**, open the patient’s record in **CS Imaging**. The 3D volumes are displayed as images in the patient’s **Patient History** and **Image Gallery**.

For information on generating the 3D volumes, consult the **CS 3D Imaging User Guide**.

Viewing 3D Mesh Objects

You can view meshes that contain for example:

- 3D intraoral scanner images (**CS 3500, 3600 Family)**
- Mesh designs from 3D object acquisition mode
- Mesh designs from **CS Model, CS Model+**, or **CS Restore**

You can use the mouse to rotate and zoom on mesh objects.
The **Patient Browser** appears when you launch **CS Imaging** in standalone mode. This provides all patient management functions.

When you open **CS Imaging** from your DPMS, the **Dashboard** appears. It is like the **Patient Browser**, except that you do not see the following functions: I, J, K.

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td><strong>Title bar</strong></td>
<td>Displays the name of the selected patient.</td>
</tr>
</tbody>
</table>
| B | **System icons** | These icons allow you to access About CS Imaging, Preferences and the CS Imaging User Guide.  
**Note:** You can select the language for the user guide in the “General Preferences”. |
| C | **Image Viewing Workspace icon** | Click to open the Image Viewing Workspace. See “Using the Image Viewing Workspace”. |
| D | **Patient Card** | Displays information on the selected patient.  
**Note:** If you normally open **CS Imaging** from the DPMS, you can edit this information by opening **CS Imaging** in the standalone mode. See “Working with Patient Data in Standalone Mode”. |
| E | **Image management tools** | Contains import, export and print buttons. |
| F | **Patient History** | Displays thumbnails of acquired images and other objects for the selected patient. See “Viewing Images and Other Objects in the Patient History”. |
| G | **Image Acquisition toolbar** | Contains buttons you can click to access your acquisition devices. These tools are visible in the **Patient Browser, Dashboard, Image Viewing Workspace** and **Darkroom** mode. See “Acquiring an Image Using the Acquisition Toolbar”. |
| H | **Patient History tools** | Contains Patient History image display and sort options, and a Filter button to display/hide the Dental Arch Filter. See “Using the Dental Arch Filter”. |
| I | **Patient List** | Displays the list of available patients. See “Viewing Images and Other Objects in the Patient History”.  
**Note:** Not available in the Dashboard. |
| J | **Patient Search** | Allows you to search the Patient List. See “Searching for a Patient in the Patient List”.  
**Note:** Not available in the Dashboard. |
| K | **Patient management tools** | Contains create and modify patient functions.  
**Note:** Not available in the Dashboard. |
Image Viewing Workspace Overview

The **Image Viewing Workspace** provides tools for acquiring, reviewing, and analyzing images.

<table>
<thead>
<tr>
<th></th>
<th>Title bar</th>
<th>Displays the name of the selected patient.</th>
</tr>
</thead>
</table>
| B | System icons | These icons allow you to access About CS Imaging, Preferences and the CS Imaging User Guide.  
*Note:* You can select the language for the user guide in the “General Preferences”. |
| C | Navigation icons | Icons that you use to access Image Viewing Workspace screen options, the Patient Browser, Dashboard and the Darkroom mode. |
| D | Control Panel | Contains the Image Processing, Histogram and Dental Arch tools. See “Using the Control Panel”. |
| E | Image windows | Images are displayed in separate windows. You can resize a selected image window by moving the mouse pointer to the window border. When the mouse pointer changes to a double arrow, click and drag the window border to resize. See “Arranging Images”. |
| F | Image Acquisition toolbar | Contains buttons you can click to access your equipment. See “Acquiring an Image Using the Acquisition Toolbar”. |
| G | Image Gallery icon | Click to display thumbnails of the acquired images and objects for the selected patient. See “Using the Image Gallery”. |
| H | Dropdown Toolbar | The toolbar displayed depends on the button you select in the Toolbar Selector.  
*Note:* The white triangle in the lower-right corner of some icons means there is an icon group available. See “Using Icon Groups”. |
| I | Toolbar Selector | Toggle between the buttons to view the Drawings & Annotations, Image and Share toolbars. See “Using the Toolbars in the Image Viewing Workspace or Darkroom Mode”. |
Darkroom Mode Overview

A  Image Acquisition toolbar
   Contains buttons you can click to access your acquisition devices. See “Acquiring an Image Using the Acquisition Toolbar”.

B  Navigation icons
   Icons that you use to access the Darkroom mode screen options and Image Viewing Workspace.

C  Control Panel
   Contains the Image Processing, Histogram and Dental Arch tools. See “Using the Control Panel”.

D  Image title bar
   Contains the acquisition date and time, toggle buttons for navigating between images, and icons to access the Image Information window and save image changes. See “Overview of the Image Title Bar”.

E  Image Gallery icon
   Click to display thumbnails of the acquired images and objects for the selected patient. See “Using the Image Gallery”.

F  Dropdown Toolbar
   The toolbar displayed depends on the button you select from the Toolbar Selector (G).
   Note: The white triangle in the lower-right corner of some icons means there is an icon group available. See “Using Icon Groups”.

G  Toolbar Selector
   Toggle between the buttons to view the Drawings & Annotations, Image and Share toolbars. See “Using the Toolbars in the Image Viewing Workspace or Darkroom Mode”.

For more information on this mode, see “Using the Darkroom Mode”
Acquiring an Image Using the Acquisition Toolbar

**WARNING:** Before acquiring an image, make sure you have selected the correct patient.

**Important:** You cannot manage your device’s acquisition settings from the CS Imaging software. For information on using the device, consult its user manual.

The Image Acquisition toolbar contains icons to open acquisition software installed on your computer.

In some cases, relevant icons are grouped into an icon group. When icons share the same keyboard shortcut, the last selected icon in the icon group will be activated by the shared keyboard shortcut. For example F2 will activate either Acquire RVG or Acquire RVG FMS depending on which icon was last used in that icon group. See “Keyboard Shortcuts in Icon Groups”.

**Tip:** Hold the mouse pointer over an icon to display a tooltip.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Acquire an RVG image (F2)*" /></td>
<td>Acquire an RVG image (F2)*</td>
</tr>
<tr>
<td><img src="image" alt="Acquire an RVG FMS (F2)*" /></td>
<td>Acquire an RVG FMS (F2)*</td>
</tr>
<tr>
<td><img src="image" alt="Acquire a panoramic image (F3)" /></td>
<td>Acquire a panoramic image (F3)</td>
</tr>
<tr>
<td><img src="image" alt="Acquire a cephalometric image (F4)" /></td>
<td>Acquire a cephalometric image (F4)</td>
</tr>
<tr>
<td><img src="image" alt="Acquire an intraoral camera image (F5)" /></td>
<td>Acquire an intraoral camera image (F5)</td>
</tr>
<tr>
<td><img src="image" alt="Acquire a CR image (F6)*" /></td>
<td>Acquire a CR image (F6)*</td>
</tr>
<tr>
<td><img src="image" alt="Acquire an image from a TWAIN source (F7)*" /></td>
<td>Acquire an image from a TWAIN source (F7)*</td>
</tr>
<tr>
<td><img src="image" alt="Select a TWAIN source (F7)*" /></td>
<td>Select a TWAIN source (F7)*</td>
</tr>
<tr>
<td><img src="image" alt="Acquire a 3D image (F8)" /></td>
<td>Acquire a 3D image (F8)</td>
</tr>
<tr>
<td><img src="image" alt="Acquire a 3D object scan" /></td>
<td>Acquire a 3D object scan</td>
</tr>
<tr>
<td><img src="image" alt="Acquire a 3D VL image" /></td>
<td>Acquire a 3D VL image</td>
</tr>
<tr>
<td><img src="image" alt="Acquire a CR FMS (F6)*" /></td>
<td>Acquire a CR FMS (F6)*</td>
</tr>
</tbody>
</table>

* These keyboard shortcuts apply whichever icon is currently selected in the icon group.
Using Icon Groups

An icon group is a group of icons with related functions. Normally only one icon, the last one used, appears in the toolbar until you expand the group by clicking the white triangle that indicates an icon group.

To expand an icon group and select one of its functions, follow these steps:

1. In a toolbar, click the white triangle on the bottom right corner of an icon.
   The icon group expands alongside the toolbar to show all of the tools in the group.

2. Click on the icon you want to use.
   The icon you selected becomes the representative icon for the icon group for the current session of CS Imaging.

Keyboard Shortcuts in Icon Groups

Where keyboard shortcuts are available, one keyboard shortcut applies to all icons in the same icon group.

For example, in the Image Acquisition toolbar, and both use the keyboard shortcut F2.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description of operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>In the Darkroom mode in full screen, click to zoom in on an image.</td>
</tr>
<tr>
<td>-</td>
<td>In the Darkroom mode in full screen, click to zoom out on an image.</td>
</tr>
<tr>
<td>F1</td>
<td>Click to launch the online help.</td>
</tr>
<tr>
<td>F2</td>
<td>In the Patient Browser, click to launch an RVG acquisition.</td>
</tr>
<tr>
<td>F3</td>
<td>In the Patient Browser, click to launch a Panoramic acquisition.</td>
</tr>
<tr>
<td>F4</td>
<td>In the Patient Browser, click to launch a Cephalometric acquisition.</td>
</tr>
<tr>
<td>ALT + F4</td>
<td>Click to close the current window. If you are in the Patient Browser or Imaging Window, this operation closes CS Imaging.</td>
</tr>
<tr>
<td>F5</td>
<td>Click to launch an Intraoral acquisition.</td>
</tr>
<tr>
<td>F6</td>
<td>Click to launch a CR acquisition.</td>
</tr>
<tr>
<td>Key</td>
<td>Description of operation</td>
</tr>
<tr>
<td>-----------</td>
<td>------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>F7</td>
<td>Click to launch a TWAIN acquisition.</td>
</tr>
<tr>
<td>F8</td>
<td>Click to launch a 3D acquisition.</td>
</tr>
<tr>
<td>ESC</td>
<td>Click to close a menu.</td>
</tr>
<tr>
<td>CTRL</td>
<td>Click to select additional items to the one you have selected in a list.</td>
</tr>
<tr>
<td>CTRL + A</td>
<td>Click to select all of the images in the <strong>Image Viewing Workspace</strong>.</td>
</tr>
<tr>
<td>CTRL + D</td>
<td>Click to apply <strong>Auto-Arrange</strong> to the images in the <strong>Image Viewing Workspace</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This operation is unavailable in the <strong>Darkroom</strong> mode.</td>
</tr>
<tr>
<td>CTRL + C</td>
<td>Click to copy selected images or FMS templates to the Windows clipboard.</td>
</tr>
<tr>
<td>CTRL + O</td>
<td>Click to open the <strong>Image Gallery</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This operation is unavailable in the <strong>Darkroom</strong> mode.</td>
</tr>
<tr>
<td>CTRL + S</td>
<td>Click to save selected images or FMS templates.</td>
</tr>
<tr>
<td>CTRL + V</td>
<td>Click to paste copied images or FMS templates to another application other than the</td>
</tr>
<tr>
<td></td>
<td><strong>Image Viewing Workspace</strong>.</td>
</tr>
<tr>
<td>CTRL + Z</td>
<td>Click to undo the last operation.</td>
</tr>
</tbody>
</table>
# Using the Patient Browser and Dashboard

## Patient Browser and Dashboard Workflow

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>![icon]</td>
<td>On your computer desktop, double-click on the shortcut icon for the software. The <strong>Patient Browser</strong> appears. You are using <strong>CS Imaging</strong> in standalone mode. You can also open the software from the Windows Start menu. See &quot;Using CS Imaging when the DPMS is Unavailable&quot;.</td>
</tr>
<tr>
<td>2</td>
<td>![icon]</td>
<td>Click to set the <strong>CS Imaging</strong> preferences. See “Setting Preferences in CS Imaging”.</td>
</tr>
<tr>
<td>3</td>
<td>![icon]</td>
<td>Use the <strong>Patient Search</strong> box to find a patient in the <strong>Patient List</strong>. This option only applies to those using the software in standalone mode. See “Searching for a Patient in the Patient List”.</td>
</tr>
</tbody>
</table>
| 4    | ![icon] | Click to create or edit a **Patient Card**. See:  
  - “Creating a Patient Card”  
  - “Modifying a Patient Card”  
These options only apply to those using the software in standalone mode. |
| 5    | ![icon] | Click to acquire new objects (images, 3D volumes etc, according to connected acquisition devices). See “Acquiring an Image Using the Acquisition Toolbar”. |
| 6    | ![image] | Review image thumbnails in the **Patient History**. See “Viewing Images and Other Objects in the Patient History”. You can double-click on a thumbnail to open the image in the **Image Viewing Workspace**. |
| 7    | ![icon] | Click to import or export objects. See “Importing and Exporting Images”. |
| 8    | ![icon] | Click to open the **Image Viewing Workspace**. You can also open the **Image Viewing Workspace** by double-clicking on an image thumbnail or a patient name. |
## Icons Available in the Patient Browser and Dashboard

In some cases, relevant icons are grouped into an icon group. See “Using Icon Groups”.

In the **Patient Browser** and **Dashboard**, you can find the following icons:

<table>
<thead>
<tr>
<th>System icons</th>
<th>Click to view information about CS Imaging.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Click to configure the <strong>CS Imaging</strong> preferences. See “Setting Preferences in CS Imaging”.</td>
</tr>
<tr>
<td></td>
<td>Click to open the <strong>CS Imaging User Guide</strong>. <strong>Note</strong>: You can select the language for the user guide in the “General Preferences”.</td>
</tr>
<tr>
<td>Image Acquisition icons</td>
<td>Click to acquire images. The icons that appear depend on the acquisition devices you are using. See “Acquiring an Image Using the Acquisition Toolbar”.</td>
</tr>
<tr>
<td>Open Image Viewing Workspace icon</td>
<td>Click to open the <strong>Image Viewing Workspace</strong>, which displays the images that you selected in the <strong>Patient History</strong>. See “Image Viewing Workspace Overview”.</td>
</tr>
<tr>
<td>Patient Card icons</td>
<td><strong>Note</strong>: These icons are not available in the <strong>Dashboard</strong>. Click to create a <strong>Patient Card</strong>. See “Creating a Patient Card”.</td>
</tr>
<tr>
<td></td>
<td>Click to modify a <strong>Patient Card</strong>. See “Modifying a Patient Card”.</td>
</tr>
<tr>
<td>Export icon group</td>
<td>Click the small, white triangle to expand the icon group. Click to save selected images to another location. See “Exporting Images to a Folder or an Email”.</td>
</tr>
<tr>
<td></td>
<td>Click to send selected images to one or more email addresses. See “Exporting Images to a Folder or an Email”.</td>
</tr>
<tr>
<td></td>
<td>Click to send selected images to <strong>CS Connect</strong>. <strong>Note</strong>: This icon is only available if <strong>CS Connect</strong> is installed.</td>
</tr>
<tr>
<td></td>
<td>Click to print selected images. See “Printing Images”.</td>
</tr>
<tr>
<td></td>
<td>Click to export selected images to a DICOMDIR folder. See “Exporting DICOMDIR”.</td>
</tr>
<tr>
<td>Import icon group</td>
<td>Click the small, white triangle to expand the icon group. Click to import images from a folder. See “Importing Images”.</td>
</tr>
<tr>
<td></td>
<td>Click to import images from a DICOMDIR folder. See “Importing DICOM Images”.</td>
</tr>
</tbody>
</table>
Overlays Available in Patient Browser and Dashboard

The following images can be displayed:

<table>
<thead>
<tr>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Ceph Image" /></td>
<td>Shows a Ceph image that has a Ceph tracing.</td>
</tr>
<tr>
<td><img src="image2.png" alt="3D Tooth" /></td>
<td>When you see 3D in the left-hand corner of the image, it is a 3D object.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Tooth Number" /></td>
<td>The #13 in the upper left-hand corner, is a tooth number. (Note: only the first tooth will be displayed by default if you have multiple teeth).</td>
</tr>
<tr>
<td><img src="image4.png" alt="3D MAR Symbol" /></td>
<td>The 3D MAR symbol in the upper left-hand corner means there is a 3D MAR reconstruction.</td>
</tr>
</tbody>
</table>

Using CS Imaging when the DPMS is Unavailable

When the Dental Patient Management System (DPMS) is unavailable to launch CS Imaging, or on computers on which the DPMS is not installed, you can still access existing patient images and acquire new images for a patient.

When you open CS Imaging from your DPMS, the Dashboard appears. When you open CS Imaging in the standalone mode, the Patient Browser appears. The Patient Browser is similar to the Dashboard, except that you also have access to a Patient List showing available patients, a Patient List filter, and other patient management functions.

You can click on patients in the Patient List to access their images in the database and acquire images for that patient.

⚠️ Important: The Patient List displays only the patients that you have previously opened in CS Imaging Version 8 using the DPMS. If you have not opened a patient using the DPMS using Version 8, then the patient will not appear in the list.

You can complete all of the usual functions of CS Imaging and newly acquired images are saved in the patient file directory.

To open CS Imaging when the DPMS is unavailable or on computers on which the DPMS is not installed, do one of the following:

- Click ![Computer Screen](image5.png) on the computer screen.
- From the Start menu:
1. In All Programs, scroll to the Carestream folder.

2. Click to open the Carestream folder, and in the CS Imaging Software folder, click CS Imaging Software.

CS Imaging opens in the standalone mode, and the Patient Browser appears.
Working with Patient Data in Standalone Mode

CS Imaging works with Carestream Dental and other DPMSs. You can also use CS Imaging in standalone mode and keep track of your patients in the CS Imaging Patient List.

When you start CS Imaging in standalone mode, the Patient Browser appears. It contains:

- A list of patients in the database.
- Tools to create and work with patient records.
- Tools to import images for a patient.
- The Patient History, in which you can select images to view in the Image Viewing Workspace.

Important: As a security measure, you can only view and modify images for one patient at a time in the Image Viewing Workspace.

Creating a Patient Card

If you are using CS Imaging in standalone mode, instead of with a DPMS that already contains patient records, you must create a Patient Card before you can acquire images for that patient.

To create a Patient Card, follow these steps:

1. Open CS Imaging in the standalone mode.
   See “Using CS Imaging when the DPMS is Unavailable”.
   The Patient Browser appears.

2. In the Patient Browser, click 
   The Patient Card window appears.

3. Enter patient information in the Patient Card window.
   Note: The First Name and Last Name fields are mandatory. All other fields are optional. Shaded fields are completed by CS Imaging and cannot be edited.

4. When you have finished entering data, click OK.
   The Patient Card window closes, and the new patient appears in the Patient List.

Adding a Picture to a Patient Card

To add a picture to a Patient Card, follow these steps:

1. Open CS Imaging in the standalone mode.
   See “Using CS Imaging when the DPMS is Unavailable”.
   The Patient Browser appears.
2 Select the patient in the **Patient List** and click .

3 In the **Patient Card** window, click **Switch to full version**.
   The **Patient Card** window expands to display additional fields.

4 Scroll to the top of the expanded **Patient Card** window, and click **Change Picture**.
   The **Select patient photo** window appears.

5 In the **Select patient photo** window, browse to locate the picture file you want to use and click to select it.
   Note: The default file type is BMP, but you can use other file formats. Click the file type drop-down list alongside the **File name** field to select a different file type.
   The selected file name is added to the **File name** field.

6 Click **Open**.
   The selected picture file is added to the **Patient Card**.

7 Click **Save Changes** and close the **Patient Card** window.

### Sorting the Patient List

In the **Patient Browser** above the **Patient List**, you can use the following filters:

- Family Name
- First Name
- Identifier
- Social Security Number

The selected filter is applied until you clear the filter, or until you close the software. You can also search for a specific patient in the list. See “Searching for a Patient in the Patient List”.

To change how the **Patient List** is sorted, follow these steps:

1 Open **CS Imaging** in the standalone mode.
   See “Using CS Imaging when the DPMS is Unavailable”.
   The **Patient Browser** appears.

2 Do one of the following:
   - To change sort order from ascending to descending, click the small triangle alongside the sort filter.
   - To select a different sort filter, right-click on the current filter, and click to select a different filter.

### Searching for a Patient in the Patient List

To search for a patient, follow these steps:
1 Open **CS Imaging** in the standalone mode.

See “Using CS Imaging when the DPMS is Unavailable”.

The **Patient Browser** appears.

2 Click in the **Patient Search** box.

3 Enter text that will be used to search in the **First name**, **Last name**, **SSN** (social security number) and **Patient identifier** fields.

The **Patient List** is updated as you type.

When matches are found, the patients are displayed in the **Patient List**.

---

### Deleting a Patient Card

![Important: Once the Patient Card has been deleted, you cannot retrieve this data.](image)

To delete a **Patient Card**, follow these steps:

1 Open **CS Imaging** in the standalone mode.

   See “Using CS Imaging when the DPMS is Unavailable”.

   The **Patient Browser** appears.

2 In the **Patient Browser**, select the patient you want to delete in the **Patient List** and click ![Patient Card](image)

   The **Patient Card** window appears.

3 In the **Patient Card** window, click **Switch to full version** at the top of the window.

   The **Patient Card** window expands to display additional fields.

4 At the top of the expanded **Patient Card** window, click **Delete this patient**.

   A warning window appears.

   ![Note: If the option does not appear, then the Allow deletion of patient cards and images setting has been deactivated in the “Service Preferences”](image)

5 To confirm that you want to delete the selected **Patient Card**, click **Delete**.

   The selected patient and all associated images are deleted.

---

### Viewing a Patient Card

To view a **Patient Card**, follow these steps:

1 Open **CS Imaging** in the standalone mode.

   See “Using CS Imaging when the DPMS is Unavailable”.

   The **Patient Browser** appears.
1 In the Patient Browser, select a patient in the Patient List.
2 Click Expand in the Patient Card.
   The complete list of information on the patient appears.
3 When you have finished viewing the Patient Card, click Collapse to minimize the Patient Card information.

Modifying a Patient Card
To modify a Patient Card, follow these steps:
1 Open CS Imaging in the standalone mode.
   See "Using CS Imaging when the DPMS is Unavailable".
   The Patient Browser appears.
2 In the Patient Browser, select a patient in the Patient List.
3 Click .
   The Patient Card window opens.
4 Make the changes you need in the Patient Card.
5 When you have finished making changes, do one of the following:
   • Click Cancel to close the Patient Card without saving your changes.
   • Click OK to save your changes and close the Patient Card.

Using the Dental Arch Filter
You can use the Dental Arch Filter to filter images displayed in the Patient History according to the following criteria:

- Tooth number
- Image acquisition modality (intraoral, panoramic, camera, and so on)
The Dental Arch Filter contains the following functions:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td><strong>Dental Arch Filter</strong> Filter by one or more tooth numbers using the following indications:</td>
</tr>
<tr>
<td></td>
<td>- Light gray tooth: Images are available</td>
</tr>
<tr>
<td></td>
<td>- Dark gray tooth: No images are available</td>
</tr>
<tr>
<td></td>
<td>- Blue items: Currently active filter elements</td>
</tr>
<tr>
<td>B</td>
<td><strong>Dentition Icons</strong> Switch between adult and deciduous teeth.</td>
</tr>
<tr>
<td>C</td>
<td><strong>Modality Filter</strong> Filter by the acquisition modalities that are available for the current patient. For example, if only cephalometric images are available, this function will only display Cephalometric.</td>
</tr>
</tbody>
</table>

**Note:** If you close the Dental Arch Filter, your filter selection remains active.

**Important:** You cannot use the Dental Arch Filter and the Date filter at the same time.

Prerequisite:

- If you are in the Patient Browser standalone mode, select a patient in the Patient List. All image thumbnails for the selected patient are displayed in the Patient History.

To use the Dental Arch Filter, follow these steps:

1. In the Patient History tools, click Filter.
   
   The Dental Arch Filter appears above the Patient History.

2. In the Dental Arch Filter, click the dentition icon (B) to select either permanent (adult) or deciduous (child) teeth.
   
   The Dental Arch Filter (A) changes to the adult/child tooth number array.

3. Do any of the following:
   
   - In the Dental Arch Filter (A), click on one or more light gray teeth to select tooth numbers. The Patient History displays thumbnails for the selected tooth numbers.
     
     The associated tooth numbers are determined the tooth numbering system selected in the “Imaging Preferences”.
     
     You can select as many tooth numbers with images as you want.

   - In the Modality Filter (C), click one or more modality types (for example Panoramic). The Patient History automatically refreshes the display to show only images for the selected modalities.
   
     To reset the filter, click **All** in the Modality Filter (C).

   - Click selected teeth, which are lighter than teeth that are not selected, to deselect related images.
To hide the Dental Arch Filter, click Filter.

Selecting Images

In the Patient Browser or Dashboard:

- To select a single image, click on the image in the Patient History.
- To select multiple images, click on more than one image entry in the Patient History. All images that you select are opened in the Image Viewing Workspace.
- To deselect an image, click on the highlighted image entry in the Patient History. The image is removed from the Image Viewing Workspace and deselected in the Patient History.

Viewing an Image in the Image Viewing Workspace

WARNING: For image review, take into consideration that patient orientation is not displayed on the following acquired images:

- Intraoral images (RVG, camera, CR)
- Cephalometric oblique images
- CR cephalometric and panoramic images

To view an image, follow these steps:

1. Do one of the following:
   - If you are working in the standalone mode, in Patient Browser, click on a patient to display any associated images in the Patient History.
   - From your DPMS, open a Patient Card in CS Imaging.

2. Double-click the image entry in the Patient History.

The image appears in the Image Viewing Workspace.

Tip: You can select multiple images in the Patient History by clicking on each image you want to view, and then click .

Viewing Images and Other Objects in the Patient History

The Patient History displays thumbnails of images and other files for the selected patient.

In the Patient History, you can view your images in the following ways:

<table>
<thead>
<tr>
<th>View</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Thumbnail</td>
</tr>
<tr>
<td>B</td>
<td>Detail</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Note: In the list view, you can click on the comment to add short notes to the thumbnail images. See &quot;Adding a Comment to an Image&quot;.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C</th>
<th>Preview</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tip: In the preview panel, you can also rotate 3D volumes and mesh objects.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>D</th>
<th>Carousel</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>E</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort the Patient History by date. When there are several images in the Patient History, this displays the image thumbnails in date order.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>F</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort the Patient History by modality.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>G</th>
<th>Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the Dental Arch Filter to filter Patient History by tooth number/dentition/modality.</td>
<td></td>
</tr>
</tbody>
</table>

See "Using the Dental Arch Filter".
Note:

- The icon for the selected view appears in blue, for example 🔄.
- In the Thumbnail, Detail, and Preview views, if an image has the following conditions, then an icon will appear in the lower corner of the thumbnail:
  - Implants (3D and 2D images)
  - Tracings (Cephalometric 2D images)
Adding a Comment to an Image

To add a comment to an image, follow these steps:

1. In the Patient History toolbar, click to select the detail view. Existing comments are displayed alongside the image thumbnail.

2. Click on an image thumbnail to select it. A blue frame appears around the thumbnail.

3. On the selected thumbnail, click on the comment (A). A small text editor field appears.

4. In the text field, enter and edit comments as necessary.

5. Click away from the text field to save your comment.

Note: Only the first three lines of the comment can be displayed in the Patient History. To see all of the text, click on the comment section or hover the mouse pointer over the image to display all of the text in a tooltip.
Reassigning Images and Other Objects to a Different Patient

When you acquire an image and find that it was assigned to the wrong patient, you can easily reassign it and other objects to a different patient record.

Important: If you are using CS Imaging with the DPMS, then you can only reassign images to patients that you previously opened in CS Imaging Version 8 using the DPMS. If you have not opened a patient using the DPMS using Version 8, then the patient will not appear in the list of patients.

To move objects from Patient A to Patient B using the right-click menu, follow these steps:

1. In the Patient History for Patient A, click to select one or more objects that you want to reassign to Patient B.
2. Right-click on the images and select Assign to another patient from the shortcut menu.
   An Assign To window appears, showing a list of available patients.
3. To filter the list, in the text box below Destination patient, type the first letter of the patient name, and the list is updated automatically.
4. Select Patient B and click Assign.
   The selected objects are moved to Patient B.

To move objects from Patient A to Patient B by drag and drop, follow these steps:

1. Open CS Imaging in the standalone mode.
   See “Using CS Imaging when the DPMS is Unavailable”.
   The Patient Browser appears.
2. In the Patient History for Patient A, click to select one or more objects that you want to reassign to Patient B, and drag the selected objects to Patient B in the Patient List.
   As you drag the objects, the mouse pointer changes to to show that you are moving the objects.
   An Assign To window appears, highlighting the selected destination patient in the list of available patients.
3. Click Assign to confirm the move.
   The selected objects are moved to Patient B.
Deleting Images

To delete images from the patient database in the Patient Browser or Dashboard, follow these steps:

1. In the Patient History, click on the images you want to delete.
2. Right-click on the images and select Delete.

   **Note:** If Delete does not appear in the right-click menu, then the Allow deletion of patient cards and images option has been deactivated in “Service Preferences”.

   The Delete window appears, prompting you to confirm that you want to delete the selected images. All of the images that you are about delete are highlighted in red.

   **Important:** The selected images will be permanently removed from the image database!

3. If you are sure that you want to proceed, click Delete.
4 Using the Image Viewing Workspace

Overview of the Image Title Bar

In the Image Viewing Workspace, the title bar of an image contains the following information and controls.

A Click to display the Image Information window. “Displaying the Image Information Window”.

B Click to save image changes. “Saving Images in the Image Viewing Workspace or Darkroom Mode”.

C Image tooth number [where applicable] and acquisition date.

D Click to reset the following image settings to the original acquisition state:
- Brightness, contrast, and gamma adjustments in the Control Panel. “Adjusting Image Brightness, Contrast and Gamma in 2D Images”.
- The following Image toolbar functions:
  - Negative
  - Colors #1
  - Colors #2
“Resetting Images”.

E Click to close the image.

When the image is selected in the Image Viewing Workspace for editing, the title bar appears in blue. If the images is not selected, the title bar appears in black.

Using the Screen Options

In the Image Viewing Workspace, click to access the following screen options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear Workspace</td>
<td>Click to clear the workspace of images.</td>
</tr>
<tr>
<td>Auto-Arrange</td>
<td>Click to activate Auto-Arrange. “Using Auto-Arrange”.</td>
</tr>
<tr>
<td>Display Drawings</td>
<td>Click to show or hide image drawings you have added using the Drawings &amp; Annotations toolbar. “Using the Drawings &amp; Annotations Toolbar”.</td>
</tr>
<tr>
<td>Display Information</td>
<td>Click to show or hide patient and acquisition information as an overlay on images. “System-Generated Image Overlays”.</td>
</tr>
<tr>
<td>Display Measurements</td>
<td>Click to show or hide measurements on images. “Using Measurements to Calculate Distances and Angles”.</td>
</tr>
</tbody>
</table>
In the Image Viewing Workspace, you can do the following to organize images:

- You can manually resize and drag images to any location on your computer screen.
- You can allow CS Imaging to organize images on your computer screen.

Using Auto-Arrange

The benefits of using the Auto-Arrange are:

- To maximize the use of available Image Viewing Workspace.
- To adjust image sizes for the largest display possible without overlap.
- To arrange the display in the most useful manner.

For example, in the case where you have one panoramic image and four RVG images, the panoramic uses all the horizontal space available across the bottom of the Image Viewing Workspace, with the four RVG images displayed above it.

To activate Auto-Arrange in the Image Viewing Workspace, do one of the following:

- Click the Screen Options icon ( ) and select Auto-Arrange. “Using the Screen Options”.
- Right-click on the Image Viewing Workspace and select Auto-Arrange.

The arrow icon changes from red to blue.

Note:
- When you select Auto-Arrange all images are automatically reorganized and resized inside the Image Viewing Workspace, regardless of where you have moved them.
- If you move at least one image even slightly, the Auto-Arrange is deactivated.

To turn off Auto-Arrange, do one of the following:

- In the Image Viewing Workspace, manually move or resize an image.
- Click the Screen Options icon ( ) and deselect Auto-Arrange. The arrow icon next to the option changes from blue to red.
**Manually Arranging Images**

You can manually move images to any place in the workspace, or float them on top of other images, other parts of the application, or outside the application (if the application is restored down or you have more than one computer monitor).

Once you have opened one or more images in the **Image Viewing Workspace**, you can manually organize and arrange your workspace.

<table>
<thead>
<tr>
<th>To do this action...</th>
<th>Do the following...</th>
</tr>
</thead>
</table>
| To move an image in the **Image Viewing Workspace**... | Click and drag down the title bar of the image to move the whole image to a new position in the workspace.  
**Tip:** You can drag an image outside the application when:  
- It is not maximized to full computer screen.  
- You are using more than one monitor.  
If you work with images outside the workspace, you can drag and drop them back onto the workspace, or simply move the application screen with the mouse to "recapture" the images into the workspace.  
**Tip:** The quickest way to get all of your images back into the workspace is to activate **Auto-Arrange**. |
| To select and deselect images in the **Image Viewing Workspace**... | Do one of the following:  
- Click on an image. The title bar and frame around the image are highlighted in blue to show that it has been selected.  
- To select multiple images, hold the **Ctrl** key down while clicking the images you want to select. All selected images are displayed with blue title bars and frames.  
- To select all images, press **Ctrl + A**. All images are selected and displayed with blue title bars and frames  
- To deselect all images, click anywhere on the **Image Viewing Workspace** outside of any image. All images are deselected. |
| To resize an image in the **Image Viewing Workspace**... | Click and drag on the image border. As the image is resized, the ratio of image height and width remains constant. |
| To close all images in the **Image Viewing Workspace**... | Do one of the following:  
- Click the **Screen Options** icon and select **Clear Workspace**. All images are cleared from the **Image Viewing Workspace**. “Using the Screen Options”  
- Right-click on the **Image Viewing Workspace** and select **Clear Workspace**. |

**Using an Analysis**

In the **Image Viewing Workspace**, an **Analysis** can store a configuration of the workspace that includes:

- The images being viewed in the workspace (including FMS templates).
- Size and position of images (unless you have activated **Auto-Arrange**).
- Any filters that you have applied to one or more individual images.
• Any measurements, drawings or annotations attached to the images.

**Note:** If you have activated Auto-Arrange, the size and position of the images are controlled by the Auto-Arrange when you open an Analysis. “Using Auto-Arrange”.

You can have more than one Analysis stored in CS Imaging, but only one Analysis can be used at a time.

**Using the Default Workspace Analysis**

Every time you exit the Image Viewing Workspace for a patient, the default Analysis is automatically updated to reflect the layout on the workspace. When you return to the patient’s workspace, even after closing and reopening the software, the default Analysis shows the layout of the workspace as it was when you last exited the workspace.

To use a default Analysis, you need to activate the Automatically open default analysis option in “Save Preferences”.

**Creating an Analysis**

When you create an Analysis, you are saving the current state of the Image Viewing Workspace.

To create an Analysis, follow these steps:

1. In the Image Viewing Workspace, click .
2. From the Screen Options drop-down list, select Save Analysis.
   The Analysis window appears.
3. Click Create.
4. In the Title field, enter a name for the analysis, and if necessary add any comments in the Comments field.
5. Click Save, and then Close to close the Analysis window.

**Editing an Analysis**

To edit an Analysis, follow these steps:

1. In the Image Viewing Workspace, click .
2. From the Screen Options drop-down list, select Load Analysis.
   The Analysis window appears.
3. Select the Analysis you want to edit, and click Edit.
   **Note:** You cannot edit the default analysis. If you click Edit and nothing happens, make sure you select an analysis that you have created and not the default analysis.
4. Edit the Title and Comments as necessary.
5. Click Save, and then Close to close the Analysis window.
Opening an Analysis

When you open an Analysis, you are resetting your Image Viewing Workspace to a previously saved state.

Tip: Make sure you save any changes you need to keep in your Image Viewing Workspace before you open an Analysis. You can even save your current setup as a new analysis.

To open an Analysis, follow these steps:

1. In the Image Viewing Workspace, click .
2. From the Screen Options drop-down list, select Load Analysis.
   The Analysis window appears.
3. Select an Analysis and click Open.
   The Image Viewing Workspace shows the selected analysis.

Deleting an Analysis

To delete an Analysis, follow these steps:

1. In the Image Viewing Workspace, click .
2. From the Screen Options drop-down list, select Load Analysis.
   The Analysis window appears.
3. Select the Analysis you want to delete.
   The selected Analysis is highlighted in blue.
4. Click Delete.
   A message prompts you to confirm the deletion.
5. Click OK to confirm.
6. Click Close to close the Analysis window.
5 Using the Darkroom Mode

In the **Darkroom** mode, an image is enlarged to fit the entire computer screen, which is useful when you want to concentrate on a large view of a single image, either for diagnostic purposes or to provide an explanation to a patient.

To display an image in the **Darkroom** mode, select one or more images in the **Image Viewing Workspace** and do one of the following:

- Double-click the selected images.
- Right-click the selected images and select **Darkroom**.
- Click 📺.

If you select more than one image, then in the **Darkroom** mode you can toggle through them in one of the following ways:

- Use arrows on the **Darkroom** title bar. See “Overview of the Image Title Bar”.
- Use the left and right arrow keys on your computer keyboard.

**Tools available in the Darkroom Mode**

You can use the following tools in the **Darkroom** mode:

- “Using the Control Panel”
  - “Images using Pre-Defined Anatomical Mode Filters”
  - “Images using CS Adapt Library Favorites”
  - “Zooming in and out Using the Localization Tool”
- “Using the Alt Key to Adjust Image Properties”
- “Overview of the Image Title Bar”
- “Using the Toolbars in the Image Viewing Workspace or Darkroom Mode”
- “Using the Screen Options”
- “Using the Image Gallery”
- “Acquiring an Image Using the Acquisition Toolbar”
Overview of the Image Title Bar

In the Darkroom mode, at the bottom of an image, the a title bar offers the following information and functions.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibration/Crop status:</td>
<td>Click to toggle to the image preceding the current image.</td>
<td>Tooth number (where applicable for intraoral images)</td>
<td>Acquisition date and time</td>
<td>Click to display the Image Information window.</td>
<td>Click to save image changes.</td>
<td>Click to toggle to the image following the current image.</td>
<td>The equipment used to acquire the image.</td>
</tr>
<tr>
<td>: Image has been calibrated.</td>
<td>: Image has not been calibrated.</td>
<td>: Image has been cropped. See “Cropping Images”.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Zooming in and out Using the Localization Tool

You can use the Localization tool in the Control Panel to change the zoom level of the displayed image and to pan around the zoomed image.

**Tip:** You can click anywhere on the image and use the mouse wheel to zoom in and out.

For more information on the Control Panel, see “Using the Control Panel”

To zoom in and out on an image in the Darkroom mode, follow these steps:

1. From the Image Viewing Workspace or Image Gallery, open an image in the Darkroom mode.
2. Click to open the Control Panel.
3 Click (A) to show the Localization tool.

The Localization tool offers the following features.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Click ( \text{ Localization} ) to view the Localization tool.</td>
</tr>
<tr>
<td>B</td>
<td>Preview section that shows the image viewed in the zoom selection.</td>
</tr>
<tr>
<td>C</td>
<td>Use the slider to change the magnification of the preview section. When you move the slider, the preview shrinks or increases depending on the magnification you select.</td>
</tr>
<tr>
<td>D</td>
<td>Click ( \text{ } ) to reset the image to the full display in the preview section (B).</td>
</tr>
<tr>
<td>E</td>
<td>The display of the image on the Darkroom screen reflects the section shown in the preview. Drag with the mouse button this preview section to pan around the image as it appears in the workspace.</td>
</tr>
</tbody>
</table>

Using the Screen Options

In Darkroom mode, you can access the following screen options by clicking \( \text{ } \).

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Drawings</td>
<td>Select to toggle on and off the display of objects you have added to images using the Drawings &amp; Annotations toolbar. See “Using the Drawings &amp; Annotations Toolbar”.</td>
</tr>
<tr>
<td>Display Information</td>
<td>Select to toggle on and off patient and acquisition information on images. See “System-Generated Image Overlays”.</td>
</tr>
<tr>
<td>Display Measurements</td>
<td>Select to toggle on and off the Measurements list. See “Using the Measurements List in the Image Viewing Workspace or Darkroom Mode”.</td>
</tr>
</tbody>
</table>

Exiting the Darkroom mode

To exit Darkroom mode and return to the Image Viewing Workspace, do one of the following:

- Press Escape.
- Right-click on the displayed image and select Exit Darkroom.
- Click \( \text{ } \).
The analysis of digital radiographic images is the core function of **CS Imaging**.

**WARNING:** When you are viewing an image, take into consideration the following:
- The patient orientation is not displayed on cephalometric oblique, or intraoral and extraoral color images.
- When you acquire an image, make sure you have selected the correct patient.

### Using the Toolbars in the Image Viewing Workspace or Darkroom Mode

In the Image Viewing Workspace and Darkroom mode, you can toggle between the Image, Drawings & Annotations and Share toolbars.

<table>
<thead>
<tr>
<th>A</th>
<th>Toolbar Selector</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Toggle between the buttons to view the <strong>Drawings &amp; Annotations</strong>, Image and Share toolbars.</td>
</tr>
<tr>
<td></td>
<td>For information on these toolbars, see:</td>
</tr>
<tr>
<td></td>
<td>- “Using the Drawings &amp; Annotations Toolbar”.</td>
</tr>
<tr>
<td></td>
<td>- “Using the Image Toolbar”.</td>
</tr>
<tr>
<td></td>
<td>- “Using the Share Toolbar”.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>B</th>
<th>Dropdown toolbar</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The dropdown toolbar displayed depends on the button you select in the Image Toolbar Selector (A).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The white triangle in the lower-right corner of some icons means there is an icon group available. See “Using Icon Groups”.</td>
</tr>
</tbody>
</table>
Using the Drawings & Annotations Toolbar

**WARNING:**
- All image measurements are indicative only. Measuring and positioning tasks are carried out under your own responsibility.
- For accurate measurements, images must be calibrated using a reference object of known length.
- For panoramic images, calibration and measurement are reliable only around the reference objects of known length.

The Drawings & Annotations toolbar ( ) contains icons for functions that you can apply to a selected image. Keyboard shortcuts are indicated with parenthesis "()".

In some cases, relevant icons are grouped into an icon group. See "Using Icon Groups".

Tip: Hold the mouse pointer over an icon to display a tooltip.

<table>
<thead>
<tr>
<th>Select icon</th>
<th>Use this tool to select a drawing or measurement that you want to modify. The first mouse click selects the object, and the second mouse click shows the control points.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Drawing</strong> icon group</td>
<td><strong>Note</strong>: The white triangle indicates an icon group.</td>
</tr>
<tr>
<td><strong>Straight line</strong> icon</td>
<td>See “Drawing a Straight Line&quot;.</td>
</tr>
<tr>
<td><strong>Multi-segment line</strong> icon</td>
<td>See “Drawing a Multi-Segment Line (Polyline)&quot;.</td>
</tr>
<tr>
<td><strong>Freehand line</strong> icon</td>
<td>See “Drawing a Freehand Line&quot;.</td>
</tr>
<tr>
<td><strong>Spline drawing</strong> icon</td>
<td>See “Drawing a Spline Curve&quot;.</td>
</tr>
<tr>
<td><strong>Circle</strong> icon</td>
<td>See “Drawing a Circle&quot;.</td>
</tr>
<tr>
<td><strong>Ellipse</strong> icon</td>
<td>See “Drawing an Ellipse&quot;.</td>
</tr>
<tr>
<td><strong>Filled ellipse</strong> icon</td>
<td>See “Drawing an Ellipse&quot;.</td>
</tr>
<tr>
<td><strong>Rectangle</strong> icon</td>
<td>See “Drawing a Rectangle&quot;.</td>
</tr>
<tr>
<td><strong>Filled rectangle</strong> icon</td>
<td>See “Drawing a Rectangle&quot;.</td>
</tr>
<tr>
<td><strong>Landmark point</strong> icon</td>
<td>See “Adding a Landmark Point&quot;.</td>
</tr>
<tr>
<td><strong>Arrow line</strong> icon</td>
<td>See “Drawing an Arrow&quot;.</td>
</tr>
</tbody>
</table>
### Measurements icon group

- **Straight line measurement icon**
- **Multi-segment line measurement icon**
- **Angle measurement icon**
- **Orthogonal measurement icon**

**Note:** The white triangle indicates an icon group.

See “Making Measurements”.

### Text icon

See “Adding a Text Annotation to an Image”.

### Implant icon group

- **Mandibular canal icon**
- **Implants icon**

**Note:** The white triangle indicates an icon group.

See “Drawing a Mandibular Canal” and “Adding an Implant”.

### Calibration icon

See “Using Measurements to Calculate Distances and Angles”.

### Undo icon

See “Using the Undo and Redo Functions”. (Ctrl+Z)

### Redo icon

See “Using the Undo and Redo Functions”. (Ctrl+Shift+Z)

### Delete icon

Delete selected drawings, annotations or measurements.

### Color and Thickness icon

See “Changing Object Color and Line Thickness”.
Using the Image Toolbar

The Image toolbar ( ) offers functions that you can use to change the display of an image. Keyboard shortcuts are indicated with parenthesis "( )".

In some cases, relevant icons are grouped into an icon group. See “Using Icon Groups”.

Tip: Hold the mouse pointer over an icon to display a tooltip.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom icon</td>
<td>See “Using the Zoom Tool”. (Ctrl+Alt+8)</td>
</tr>
<tr>
<td>Highlight icon</td>
<td>See “Using the Highlight Tool”.</td>
</tr>
</tbody>
</table>
| Rotate icon group| 90 degree rotation icon  
Click to rotate clockwise by 90°.  
Flip icon  
Click to rotate by 180° (flip). |
| Note: The white triangle indicates an icon group. |
| Mirror icon      | Mirror icon  
Click to invert the left and right side of an image along the vertical axis, the equivalent of an inside out view. The image is seen as if from the inside of the mouth looking out. |
| Colors icon group|  
Colors #1 icon  
Click to replace grays by a color.  
Colors #2 icon  
Click to replace grays by sepia colors.  
Grayscale icon  
Click to replace colors by grays. |
| Note: The white triangle indicates an icon group.  
See “Using the Color Tools”. |
| Density icon group|  
Crop image icon  
Click to access the Crop panel. Cropping is not permanent and can be undone at any time. See “Cropping Images”.  
Isodensity dots icon  
Click to apply color to pixels of the same bone density. See “Using the Isodensity Tool”.  
Densitometric analysis icon  
Click to analyze bone density. See “Using the Densitometric Analysis Tool”. |
| Note: The white triangle indicates an icon group. |
| Filter icon group|  
Relief filter icon  
Select to enhances the outlines of the shapes of an image.  
Pseudo 3D icon  
Click to convert the levels of gray to height values. See “Using Pseudo 3D”. |
<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logicon</td>
<td>In RVG images, click to launch the Logicon Caries Detector to detect interproximal caries. <strong>Note:</strong> This tool is only available if you have the Logicon Caries Detector software installed.</td>
</tr>
<tr>
<td>Negative</td>
<td>Click to apply an inverse video effect to an image. See “Using Negative Images”.</td>
</tr>
<tr>
<td>Cosmetic module</td>
<td>Click to add cosmetic treatments to color images. <strong>Note:</strong> This tool is only available if you have the Cosmetic Imaging Module software installed.</td>
</tr>
<tr>
<td>Cephalometric Tracing</td>
<td>Click to launch the automatic cephalometric tracing tool. See &quot;Using Cephalometric Automatic Tracings&quot;. <strong>Note:</strong> This tool is only available if you have the Tracings Module software installed.</td>
</tr>
</tbody>
</table>
Using the Share Toolbar

The Share toolbar ( ) offers you functions that you can apply to an image. Keyboard shortcuts are indicated with parenthesis "( )".

In some cases, relevant icons are grouped into an icon group. See “Using Icon Groups”.

Tip: Hold the mouse pointer over an icon to display a tooltip.

<table>
<thead>
<tr>
<th>Icon Group</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slide show icon</td>
<td>Click to show images in a full-screen slide show. See “Viewing Images in Slide Show Mode”.</td>
</tr>
<tr>
<td>Print icon group</td>
<td>Print icon (Ctrl+P) Click to print images.</td>
</tr>
<tr>
<td>Note: The white triangle indicates an icon group. Print snapshot icon</td>
<td>Click to print a snapshot of all images in your Image Viewing Workspace.</td>
</tr>
<tr>
<td>Send by email icon</td>
<td>Click to send images to one or more email addresses. See “Exporting Images using Drag and Drop”.</td>
</tr>
<tr>
<td>Export icon group</td>
<td>Save As icon Click to save images to another location on the computer. See “Saving Images in the Image Viewing Workspace or Darkroom Mode”.</td>
</tr>
<tr>
<td>Note: The white triangle indicates an icon group. Send to CS Connect icon</td>
<td>Click to send images to CS Connect.</td>
</tr>
<tr>
<td>Export to DICOMDIR icon</td>
<td>Click to export images to a DICOMDIR folder.</td>
</tr>
<tr>
<td>Import icon group</td>
<td>Import from folder icon Click to import images from a folder.</td>
</tr>
<tr>
<td>Note: The white triangle indicates an icon group. Import from DICOMDIR icon</td>
<td>Click to import images from a DICOMDIR folder.</td>
</tr>
</tbody>
</table>
Viewing Images in Slide Show Mode

You can select images in the Image Viewing Workspace or Darkroom mode to review in the Slide Show mode.

To use the Slide Show mode, follow these steps:

1. In the Image Viewing Workspace, select the images you want to view in a slide show.
   
   If you are in the Darkroom mode, where you already have a collection of images that you want to view in the Slide Show mode, continue to the next step.

2. In the toolbar, select .
   
   The Slide Show mode opens to fill the computer screen. In the gallery you can see the 2D images, 3D volumes, and mesh objects you had selected.

3. If necessary, set the Slide Interval.

4. Click to start the slide show.
5 Use the slide show navigation buttons to move backwards or forwards in the slide show.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause button</td>
<td>First Slide button</td>
<td>Previous button</td>
<td>Next button</td>
<td>Last button</td>
<td>Stop button</td>
</tr>
</tbody>
</table>

Click to pause the slide show.

**Note:** When you click the **Stop** (F) button, this button changes to a **Play** icon (▶).

Click to return to the first image.

Click to return to the previous image.

Click to advance to the next image.

Click to advance to the last image.

Click to stop the slide show.

6 To close the **Slide Show** mode and return to the location in which you selected the images, either the **Image Viewing Workspace** or **Darkroom** mode, click 

**Using the Image Gallery**

The **Image Gallery** is accessed from the **Image Viewing Workspace** or **Darkroom** mode.

In the **Image Gallery**, you can:

- Open images in the **Image Viewing Workspace** or **Darkroom** mode.

  **Note:** In the **Thumbnail**, **Detail**, and **Preview** views, if an image has the following conditions, then an icon will appear in the lower corner of the thumbnail:
  - Implants (3D and 2D images)
  - Tracings (Cephalometric 2D images)

- Export to a file, email or a DICOMDIR. See “Exporting Images”.

- Send to **CS Connect**.

- Print images. See “Printing Images”.

- Delete images. See “Deleting an Image”.

- Reassign images to a different patient. See “Reassigning Images and Other Objects to a Different Patient”.

- Use **CTRL+V** to copy images to the computer clipboard so that you can paste them in a document in another application.

By default, the **Image Gallery** is not displayed at the bottom of the **Image Viewing Workspace** or **Darkroom** mode. To display it, click 

3D Implant View

Use 3D views of implants and mandibular to communicate more effectively with patients

Review implant drawings and nerve canals in 3D while moving implant controls.

Saving Images in the Image Viewing Workspace or Darkroom Mode

**Important:**
- When saving images on a network, you must ensure that enough space is available on the database server.
- If the network is unavailable, you will not be able to save the image.

To save an image, follow these steps:

1. Select the image you want to save and do one of the following:
   - Click (Image Viewing Workspace) or (Darkroom mode) on the image title bar.
   - Right-click on the image and select Save.
   - Press CTRL+S.

The Save Image window appears with a preview of the saved image.

**Note:** To save several images at once, use CTRL + click to select each image and press CTRL+S.
2 In the **Save Image** window, enter your image configuration details.

| Comments | Enter comments in this field. (Optional)  
| Note: To edit these comments at a later stage, do one of the following:  
| - For the image, click ![Re-display Save Image window](image_icon) to re-display the **Save Image** window.  
| - Edit the comments in the **Patient History**. See “Adding a Comment to an Image”.  
| Teeth (Intraoral images only) | In the **Dental Arch**, select one or more teeth that are represented in the image. The image’s tooth number is represented on this arcade as a blue tooth. The actual tooth numbers are displayed below the arcade.  
| Click ![Change display to Deciduous](image_icon) to change the display to **Deciduous** (child) dentition.  
| Click ![Change display to Permanent](image_icon) to change the display to **Permanent** (adult) dentition.  
| Bitewing Selection (Intraoral images only) | Select to define the image as a bitewing. When you select this option, the following bitewing location options are activated.  
| **not a bitewing** | Click to specify that the image is not a bitewing.  
| **LM** | Bitewing Location: Left Molar  
| **RM** | Bitewing Location: Right Molar  
| **RMP** | Bitewing Location: Right Molar and Premolar  
| **LMP** | Bitewing Location: Left Molar and Premolar  
| **LP** | Bitewing Location: Left Premolar  
| **RP** | Bitewing Location: Right Premolar  
| Exposure data (requires activation of radiological log. See “Radiological Log Preferences”.) | If necessary, enter exposure data for radiological logging. Values for extra-oral images (from CBCT) are usually entered automatically by the software and cannot be modified by the user. Values for intra-oral images (from RVG or CR) need to be entered manually.  
| **Generator** | Select the system used to acquire the image from the drop-down list.  
| **Kv** | KV setting of the acquired image.  
| **mA** | mA setting of the acquired image.  
| **mS** | Exposure time in ms of the acquired image.  
| **mGy.cm2** | Calculated dose for the acquired image.  

3 Click **Save**.

**Note:**  
- The original, unmodified image can always be recovered. See “Resetting Images”.  
- You can save the arrangement of images in the **Image Viewing Workspace**, with their annotations, as an analysis. See “Using an Analysis”.

### Deleting an Image

To delete an image from the patient database, follow these steps:
1. In the Image Viewing Workspace or Darkroom mode, right-click on the image.  
   
   **Tip:** In the Image Viewing Workspace, you can use Ctrl + click to select more than one image, and then right-click on the selection.

2. In the shortcut menu, select Delete.

   The Delete window appears, prompting you to confirm that you want to delete the selected image. The selected image is highlighted in red.

   **Note:** If Delete does not appear in the shortcut menu, then the Allow deletion of patient cards and images setting has been activated in the “Service Preferences”.

3. In the Delete window, click Delete. The selected image is permanently removed from the image database.

   **Tip:** You can select one or more images in the Image Gallery, right-click on the selections and click Delete.

### System-Generated Image Overlays

You can show and hide overlays in the Screen Options menu. According to how the Imaging preferences have been configured for CS Imaging, the following system-generated image overlays can appear.
**Filter indicator**
In certain conditions, an altered image has a symbol displayed in the top left corner.
The symbol displayed depends on the type of image processing that has been applied to the image.
**Fi (All images):** Sets of predefined brightness/contrast filters arranged in groups/families filter has been applied. For more information see:
- "Using the Histogram".
- "Images using CS Adapt Library Favorites".
- "Images using Pre-Defined Anatomical Mode Filters".
For Cephalometric images only:
**Fi1: Cephalometric Optimized** filter has been applied.
**Fi2: Cephalometric Bone Density** filter has been applied.
**Fi3: Cephalometric Edges** filter has been applied.
See “Using the Image Processing Tool”.

**Calibration or Crop status:**
- : Image has been calibrated.
- : Image has not been calibrated. See “Using Measurements to Calculate Distances and Angles”.
- : Image has been cropped. See “Cropping Images”.

**Dosimeter indicator**
When dosimeter information is available, this indicator appears only on a radiographic image acquisitions that has just been acquired and not yet saved.
Once the new image has been saved, the dosimeter indicator no longer appears in the image overlay.
For radiographic images, you can find the dosimeter information in the **Image Information** window.
See “Displaying the Image Information Window”.
**Note:** You activate or deactivate this feature in the “Imaging Preferences”.

**Equipment brand logo** (if available)
To show or hide this overlay, see “Imaging Preferences”.

For more information on the **Screen Options** menu, see:
- “Using the Screen Options”.

### Understanding the Dosimeter Indicator
The dose indicator is displayed at the bottom of relevant radiographic images.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
</table>
| Red and low        | A dose indicator that displays red to the left of the band denotes an under-exposed image.  
                      To improve such an image, increase the x-ray dose by increasing the exposure time or mA value. |
| Red and high       | A dose indicator that displays red to the right of the band denotes an overexposed image.  
                      To correct this, decrease the X-ray dose by decreasing the exposure time or mA value. |
| Green and mid-range| A dose indicator that displays green, denotes a correctly exposed image.         |
Displaying Image Information in Overlays

You can display or hide overlays on images in the Image Viewing Workspace or Darkroom mode.

To display the basic information overlays, in the Image Viewing Workspace or Darkroom mode, click to view the Screen Options menu, and select Display Information.

The following overlays are displayed on all images.

A | Patient information
B | Image acquisition information (varies according to image type)

Enhancing Images to Aid Diagnosis

CS Imaging provides many functions to aid diagnosis.

For example you can adjust the contrast of an image to highlight tissue type and regions of interests, or you can use colors when searching for problems that might be hard to see in a normal grayscale image.

---

Important: This section describes tools that enable you to select and customize the image rendering. Make sure that any modification will be relevant to your clinical practice. The software is an aide to diagnosis only. It is ultimately your responsibility to make the correct judgements before deciding on a course of treatment.

---

WARNING: For image review, take into consideration that patient orientation:

- Is not displayed on cephalometric oblique images and color images.
- Is indicated by tooth number on intraoral images (RVG, camera, CR).
- Must be checked for CR panoramic and cephalometric images and corrected if necessary.
We suggest the following workflows for enhancing images.

<table>
<thead>
<tr>
<th></th>
<th>Display the image or images you want to work with in the <strong>Image Viewing Workspace</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>• “Viewing an Image in the Image Viewing Workspace”.</td>
</tr>
<tr>
<td></td>
<td>• “Acquiring an Image Using the Acquisition Toolbar”.</td>
</tr>
<tr>
<td></td>
<td>• “Arranging Images”.</td>
</tr>
<tr>
<td></td>
<td>• “Using FMS”.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Make quick adjustments or apply a basic filter. The filters that are available depend on the image modality.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>• “Using the Image Processing Tool”.</td>
</tr>
<tr>
<td></td>
<td>• “Adjusting Image Brightness, Contrast and Gamma in 2D Images”.</td>
</tr>
<tr>
<td></td>
<td>• “Using the Toolbars in the Image Viewing Workspace or Darkroom Mode”.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Add measurements and annotations.</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>• “Drawings, Measurements, and Annotations”.</td>
</tr>
<tr>
<td></td>
<td>• “Using Cephalometric Automatic Tracings”.</td>
</tr>
</tbody>
</table>

**Using the Alt Key to Adjust Image Properties**

By holding down the Alt key and clicking and dragging in an image in the **Image Viewing Workspace** or **Darkroom** mode, you can adjust image brightness and contrast as described below.

![Image window with mouse pointer changes to](image.png)

As you click and drag in the image window, the mouse pointer changes to 

A Adjust brightness by holding down the Alt key and clicking and dragging horizontally (left to increase, right to decrease).

B Adjust contrast by holding down the Alt key and clicking and dragging vertically (up to increase, down to decrease).

**Using the Control Panel**

In the lower, right-hand corner of the **Image Viewing Workspace** or **Darkroom** mode, the icon allows you access to the **Control Panel**.
This panel contains the following tabs.

<table>
<thead>
<tr>
<th>A</th>
<th>Image Processing</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>See &quot;Using the Image Processing Tool&quot;.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>B</th>
<th>Histogram</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>See “Using the Histogram”.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>C</th>
<th>The tool available for this tab depends on the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• In the Image Viewing Workspace, the icon allows you access to the Dental Arch indicator. See “Using the Dental Arch Indicator in the Image Viewing Workspace”.</td>
</tr>
<tr>
<td></td>
<td>• In the Darkroom mode, the icon allows you access to the Localization tool. See “Zooming in and out Using the Localization Tool”.</td>
</tr>
</tbody>
</table>

**Using the Image Processing Tool**

Available in the Control Panel, the Image Processing tool displays different controls depending on the type of selected image, whether radiographic or color, and the acquisition equipment used to generate the image.

This section describes the following variations of the Image Processing for radiographic images:

- Images using pre-defined anatomical mode filters
- Images using CS Adapt Library Favorites

For color images, follow these steps:

1. Click on an image in the Image Viewing Workspace or Darkroom mode.
2. In the lower, right-hand corner of the workspace or Darkroom, click to open the Control Panel.
3. Click to display the Image Processing tab.
4. The filters that you see depend on the type of image.

   The Filter toolbar displays a set of filter icons that reflect the type of image you have selected:
   - "Images using Pre-Defined Anatomical Mode Filters".
   - "Images using CS Adapt Library Favorites".

   **Note:**
   - Hold the mouse pointer over a filter icon to display its name in a tooltip.
   - There are no filters available for color (camera), TWAIN acquisitions or non-CS imported images.
   - If you systematically need to adjust images, consider changing default settings in the “Image Processing Preferences”.

5. On some intraoral and some cephalometric extraoral images, you can apply the Sharpness filter.

**Adjusting Image Brightness, Contrast and Gamma in 2D Images**

You can adjust the brightness, contrast and gamma in 2D images in the following ways:
• In the **Image Processing** tab, you can use the following slider controls.

<table>
<thead>
<tr>
<th>Slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Brightness</strong></td>
<td>Adjusts the white pixel count in the image, straightening the Transfer function along the top right edge of the Histogram. To change the brightness, click and drag the brightness slider right to increase brightness, or left to decrease brightness.</td>
</tr>
<tr>
<td><strong>Contrast</strong></td>
<td>Adjusts the black and white pixel counts, straightening the Transfer function along the top right and bottom left edges of the Histogram. To change the contrast, click and drag the contrast slider right to increase contrast, or left to decrease contrast.</td>
</tr>
<tr>
<td><strong>Gamma</strong></td>
<td>Adjusts the shape of the Transfer function curve. Increasing gamma darkens the image, decreasing gamma brightens the image. To change the gamma, click and drag the gamma slider right to increase gamma, or left to decrease gamma.</td>
</tr>
</tbody>
</table>

• Use the **Transfer** function in the **Histogram** tab. See “Using the Transfer Function in a Histogram”.

• Using the Alt key. See “Using the Alt Key to Adjust Image Properties”.

**Modifying Opacity Settings in the 3D View Screen**

**Tip:** In the Adjust a Model Alignment window, the opacity of the 3D View Screen is set to 50% by default. You can modify this setting to better highlight the relative position of the model and patient volume.

To modify the opacity of a patient volume to which a Model has been matched, in the bottom right-hand pane of the Adjust a Model Alignment window, click and drag the slide adjuster.

The opacity setting of the patient volume is displayed dynamically in the 3D View Screen.
Adjusting Color Images

To adjust color images, you can use the sliders in the Image Processing tab in the Control Panel. The Image Processing tab contains the following sliders.

<table>
<thead>
<tr>
<th>Slider</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightness</td>
<td>Brightness adjusts the white pixel count in the image to straighten the Transfer function along the top right edge of the Histogram. Drag the slider control to increase or decrease brightness.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Contrast adjusts simultaneously the black and white pixel counts to straighten the Transfer function along the top right and bottom left edges of the Histogram. Drag the slider control to increase or decrease contrast.</td>
</tr>
<tr>
<td>Hue</td>
<td>Hue adjusts the image hue. Drag the slider control to increase or decrease the hue</td>
</tr>
<tr>
<td>Saturation</td>
<td>Saturation adjusts the amount of white added to a color image. The more white is added, the less saturated the color. Drag the slider control to increase or decrease saturation.</td>
</tr>
<tr>
<td>Sharpness</td>
<td>Sharpness adjusts the amount of detail displayed in an image. Drag the slider control to change the sharpness.</td>
</tr>
<tr>
<td>Emboss</td>
<td>Emboss adjusts the image relief based on the contrast between adjacent pixels. Drag the slider control to adjust the emboss effect.</td>
</tr>
</tbody>
</table>

Using the Sharpness Filter

When a relevant radiographic image is selected, the Filter toolbar in the Control Panel shows the Sharpness filter. This filter allows you to increase image contrast in intraoral and panoramic and cephalomeric extraoral images. This filter emphasizes less visible details, such as lateral canals or small fractures.

To use the Sharpness filter, in the Image Processing tool, click . To check your analysis, switch the Sharpness filter off and try using a different contrast tool, for example the Highlight tool, to confirm your findings. See "Using the Highlight Tool".

Images using Pre-Defined Anatomical Mode Filters

When a relevant radiographic image is selected, the Filter toolbar in the Control Panel provides filtering modes that enable you to enhance a specific zone.

Use the following filtering modes to manage overall image contrast.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perio Mode</td>
<td>Use this filter to optimize the display of periodontal tissues, and to search for information contained in radio-transparent tissues. The digital image becomes generally whiter, with only the periodontal area displayed effectively.</td>
</tr>
<tr>
<td>Endo Mode</td>
<td>Use this filter to optimize the contrast values over the entire grayscale range to enhance contrast at the canals and roots. It also provides good overall contrast throughout the image.</td>
</tr>
<tr>
<td>DEJ Mode</td>
<td>This filter strongly accentuates contrast in radio-opaque tissues and therefore optimizes grayscale values at the crown, the amelo-dentinal junction, and the roots. Use this filter for clearer displays of caries or lesions.</td>
</tr>
</tbody>
</table>

Panoramic
Images using CS Adapt Library Favorites

When you view an image acquired with equipment that supports CS Adapt Library filters, the Image Processing tab in the Control Panel displays:

- Relevant CS Adapt Library filter buttons.
- A button for accessing the CS Adapt Library software.

The CS Adapt Library software application allows you to:

- Create custom filters.
- Select which filters are available in the Control Panel.
- Define default acquisition filters.

There are many CS Adapt Library filters available that you can customize. For more information, see the CS Adapt Library online help in the CS Adapt Library software.

Using the Histogram

You can use the Histogram tab in the Control Panel to do the following with digital radiographic images (not color images):

- Show a graphical plot of pixel grayscale in the image.
- Adjust image brightness, contrast, and gamma.
- Use the Transfer function (an orange curve line that is a plot line of grayscale against luminance).

Adjustments made to the image, and their effect on the Transfer function, are displayed in real-time.
To display the **Histogram** tab, follow these steps:

1. Click on an image in the **Image Viewing Workspace** or **Darkroom** mode.

2. In the lower, right-hand corner of the workspace or **Darkroom**, click ![Histogram icon](image).

3. In the [Control Panel](#), click ![Histogram icon](image) to display the **Histogram** tab.

### Using the Transfer Function in a Histogram

In a **Histogram**, you can click and drag the **Transfer** function to do the following.

| A | Adjust brightness by clicking and dragging horizontally (left to increase, right to decrease). |
| B | Adjust contrast by clicking and dragging vertically (up to increase, down to decrease). |

If you adjust the brightness, contrast and gamma controls, the **Transfer** function curve will change.

<table>
<thead>
<tr>
<th>Histogram (C)</th>
<th>x-axis (horizontal)</th>
<th>Grayscale range (from black to white)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>y-axis (vertical)</td>
<td>Number of pixels</td>
</tr>
<tr>
<td>Transfer function (D)</td>
<td>x-axis (horizontal)</td>
<td>Grayscale level (black = low, white = high)</td>
</tr>
<tr>
<td></td>
<td>y-axis (vertical)</td>
<td>Pixel luminance (brightness)</td>
</tr>
</tbody>
</table>

**Note:**
- If you close a modified image, your changes will be automatically saved if the **Automatically save image modifications** option has been activated in “Save Preferences”.
- You can use the image reset function to revert to the image's acquisition state if required. See “Resetting Images”.

### Using Optiview in a Histogram

Available in the **Histogram** tab in the [Control Panel](#), Optiview helps you make adjustments without losing image detail.

To use **Optiview**, follow these steps:
1 Click on an image in the **Image Viewing Workspace** or **Darkroom** mode.

2 In the lower, right-hand corner of the workspace or **Darkroom**, click [ ].

3 In the **Control Panel**, click [ ] to display the **Histogram** tab.

4 Below the **Histogram** graph, click **Optiview**.

5 Adjust the brightness and contrast of the image.

   **While Optiview is active:**
   - Black pixels appear as blue and white pixels appear as green
   - Grayscale pixels change to blue or green as they become completely black or white. If this happens, diagnostic detail is lost, and you will need to readjust levels accordingly.

When you stop adjusting brightness and contrast, **Optiview** is deactivated automatically.

**Using the Dental Arch Indicator in the Image Viewing Workspace**

Available in the **Control Panel**, the **Dental Arch** indicator shows all of the teeth that are represented in the acquired images in the **Patient History** or **Image Gallery**. You can use this tool to assign an image to one or more teeth.

To assign one or more teeth to an image in the **Dental Arch** indicator, follow these steps:

1 Click on an image in the **Image Viewing Workspace**.

2 In the lower, right-hand corner of the workspace, click [ ].

3 In the **Control Panel**, click [ ] to display the **Dental Arch** tab.

   **Available teeth are indicated by lighter shade:** [ ].

   **Note:** The default tooth numbering system is selected in the “Imaging Preferences”.

4 Drag one or more images to a tooth in the indicator. Repeat this as necessary so that the selected images are assigned to the applicable teeth.

**Drawings, Measurements, and Annotations**

**Drawing a Straight Line**

To draw a straight line on an image, follow these steps:

1 Open the image in the **Image Viewing Workspace** or **Darkroom** mode.

2 In the **Drawings & Annotations** toolbar, in the **Line** icon group, click [ ].

   **Note:** If a white triangle appears in the lower corner of the icon, then you access to the different tools in the icon group. See “Using Icon Groups”.
3. Move the mouse pointer over the image. The pointer changes to.

4. Click on the image to set the start point of the line.

5. Click and hold, and drag the pointer over the image to draw the line.

   **Tip:** To change the line color, see “Changing Object Color and Line Thickness”.

6. Release to set the end point of the line.

   While the button is activated, you can keep adding additional lines to the image.

7. To turn off the tool, move the pointer outside the image.

### Drawing a Multi-Segment Line (Polyline)

To draw a multi-segment line on an image, follow these steps:

1. Open the image in the **Image Viewing Workspace** or **Darkroom** mode.

2. In the **Drawings & Annotations** toolbar, in the **Line** icon group, click.

   **Note:** If a white triangle appears in the lower corner of the icon, then you access to the different tools in the icon group. See “Using Icon Groups”.

3. Move the mouse pointer over the image.

   The pointer changes to.

4. Click on the image to set the start point of the polyline.

   A “+” point is drawn on the image.

5. Click again to set the second point of the polyline.

   A line is drawn from the start point to the second point.

6. Click to add additional points of the polyline as necessary.

7. Double-click on the image to set the end point of the polyline.

8. To turn off the tool, move the pointer outside the image.

### Drawing a Freehand Line

To draw a freehand line on an image, follow these steps:

**Tip:** To change the line color, see “Changing Object Color and Line Thickness”.
1. Open the image in the Image Viewing Workspace or Darkroom mode.

2. In the Drawings & Annotations toolbar, in the Line icon group, click .
   
   **Note:** If a white triangle appears in the lower corner of the icon, then you access to the different tools in the icon group. See “Using Icon Groups”.

3. Move the mouse pointer over the image.
   
   The pointer changes to .

4. Click and drag on the image to draw a freehand line.
   
   **Tip:** To change the line color, see “Changing Object Color and Line Thickness”.

5. Release the pointer to set the freehand line.
   
   A freehand line is drawn on the image.

6. To turn off the tool, move the pointer outside the image.

**Drawing a Spline Curve**

A spline curve is basically a freehand line that has editable points.

To draw a spline curve on an image, follow these steps:

1. Open the image in the Image Viewing Workspace or Darkroom mode.

2. In the Drawings & Annotations toolbar, in the Line icon group, click .
   
   **Note:** If a white triangle appears in the lower corner of the icon, then you access to the different tools in the icon group. See “Using Icon Groups”.

3. Move the mouse pointer over the image.
   
   The pointer changes to .

4. Click on the image to set the start point of the spline curve.
   
   A “+” point is drawn on the image.

5. Click again to set the second point of the spline curve.
   
   A curved line is drawn from the start point to the second point.

   **Tip:** To change the line color, see “Changing Object Color and Line Thickness”.

6. Click to add additional points to the spline curve.
Double-click on the image to set the end point of the spline curve.

To turn off the tool, move the pointer outside the image.

**Drawing a Circle**

To draw a circle on an image, follow these steps:

1. Open the image in the **Image Viewing Workspace** or **Darkroom** mode.

2. In the **Drawings & Annotations** toolbar, in the Line icon group, click ![circle icon].

   **Note:** If a white triangle appears in the lower corner of the icon, then you access to the different tools in the icon group. See “Using Icon Groups”.

3. Move the mouse pointer over the image.

   The pointer changes to ![circle pointer].

4. Click and drag on the image to draw a circle.

5. Release the pointer to set the circle on the image.

   **Tip:** To change the circle line color, see “Changing Object Color and Line Thickness”.

6. To turn off the tool, move the pointer outside the image.

**Drawing an Ellipse**

To draw an ellipse on an image, follow these steps:

1. Open the image in the **Image Viewing Workspace** or **Darkroom** mode.

2. In the **Drawings & Annotations** toolbar, in the Line icon group, click one of the following:

   - ![ellipse outline icon]
   - ![filled ellipse icon]

   **Note:** If a white triangle appears in the lower corner of the icon, then you access to the different tools in the icon group. See “Using Icon Groups”.

3. Hover the mouse pointer over the image.

   The pointer changes to ![ellipse pointer].

4. Click and drag on the image to draw an ellipse.
5. Release the mouse pointer to set the ellipse on the image.

Tip: To change the ellipse color, see “Changing Object Color and Line Thickness”.

6. To turn off the tool, move the pointer outside the image.

**Drawing a Rectangle**

To draw a rectangle on an image, follow these steps:

1. Open the image in the **Image Viewing Workspace** or **Darkroom** mode.

2. In the **Drawings & Annotations** toolbar, in the **Line** icon group, click one of the following:
   - Click ![Rectangle Outline](image) to create a rectangle outline.
   - Click ![Filled Rectangle](image) to create a filled rectangle.

   **Note:** If a white triangle appears in the lower corner of the icon, then you access to the different tools in the icon group. See “Using Icon Groups”.

3. Hover the mouse pointer over the image.

   The pointer changes to ![Pointer](image).

4. Click and drag on the image to draw a rectangle.

5. Release the mouse pointer to set the rectangle on the image.

   **Tip:** To change the rectangle color, see “Changing Object Color and Line Thickness”.

6. To turn off the tool, move the pointer outside the image.

**Adding a Landmark Point**

To add a point on an image, follow these steps:

1. Open the image in the **Image Viewing Workspace** or **Darkroom** mode.

2. In the **Drawings & Annotations** toolbar, in the **Line** icon group, click ![Point](image).

   **Note:** If a white triangle appears in the lower corner of the icon, then you access to the different tools in the icon group. See “Using Icon Groups”.

3. Move the mouse pointer over the image.
The pointer changes to .

4 Click on the image to add a point.

5 Release the mouse pointer to set the "+" point on the image.

6 Click to add additional points on the image.

7 To turn off the tool, Move the pointer outside the image.

**Drawing an Arrow**

To draw an arrow on an image, follow these steps:

1 Open the image in the *Image Viewing Workspace* or *Darkroom* mode.

2 In the **Drawings & Annotations** toolbar, in the **Line** icon group, click .

   **Tip:** To change the point color, see “Changing Object Color and Line Thickness”.

   **Note:** If a white triangle appears in the lower corner of the icon, then you access to the different tools in the icon group. See “Using Icon Groups”.

3 Move the mouse pointer over the image.

   The pointer changes to .

4 Click on the image to set the start point of the arrow.

5 Click and hold, and drag the pointer over the image to draw the arrow.

6 Release to set the end point of the arrow.

   **Tip:** To change the arrow color, see “Changing Object Color and Line Thickness”.

7 To turn off the tool, move the pointer outside the image.

**Adding a Text Annotation to an Image**

To add a text object to an image, follow these steps:

1 Open the image in the *Image Viewing Workspace* or *Darkroom* mode.

2 In the **Drawings & Annotations** toolbar, click .

3 On the image, click where you want to place the text object.

   The **Text** window appears.

4 Click in the image.

   A cursor appears.
5 Type the text you want to the image.
6 Click outside the text object to validate the text annotation.

**Editing Text Annotations**
To edit an existing text annotation, follow these steps:

1 Open the image in the *Image Viewing Workspace* or *Darkroom* mode.
2 In the **Drawings & Annotations** toolbar, click .
3 Move the mouse pointer over the text object you want to edit.
   The pointer changes to .
4 Click to select the text object.
   The text object is selected and the **Text** window appears.
5 Do any of the following:

<table>
<thead>
<tr>
<th>To reposition the text annotation...</th>
<th>Click and drag the text item to a new position.</th>
</tr>
</thead>
<tbody>
<tr>
<td>To resize the text annotation...</td>
<td>Change the font size in the <strong>Text</strong> window using the font size slider or making a selection from the font size drop-down list.</td>
</tr>
<tr>
<td>To modify the text...</td>
<td>Click the text object again. Edit the text as required.</td>
</tr>
</tbody>
</table>

6 Click outside the text object to save your changes.

**Drawing a Mandibular Canal**
The *Mandibular canal drawing* tool allows you to trace a nerve canal on an image.

To draw a mandibular canal on an image, follow these steps:

1 Open the image in the *Image Viewing Workspace* or *Darkroom* mode.
2 In the **Drawings & Annotations** toolbar, in the *Implant* icon group, click .
   **Note:** If a white triangle appears in the lower corner of the icon, then you access to the different tools in the icon group. See "Using Icon Groups".
3 Hover the mouse pointer over the image.
4 Click on the image to set the start point of the canal drawing.
   A control point is added to the image.
5 Click along the nerve canal to add additional points on the canal drawing.
   Control points are linked automatically. Control points added along the nerve canal can be used to modify the trace manually.
6 When you reach the end point of the nerve canal trace, double-click to set the end point.
Adding an Implant

The Implant Simulator tool allows you to add a virtual implant to an image.

To add an implant to an image, follow these steps:

1. View the image in the Image Viewing Workspace or Darkroom mode.

2. In the Drawings & Annotations toolbar, in the Implant icon group, click the Implant icon.

   **Note:** If a white triangle appears in the lower corner of the icon, then you access to the different tools in the icon group. See “Using Icon Groups”.

3. Click on the image at the point where you want to place the implant.

   An implant is added to the image in the current color selection and the Implants window appears.

   **Tip:** To change the implant color, see “Changing Object Color and Line Thickness”.

The nerve canal trace is drawn in the current color selection.

**Tip:** To change the color of the mandibular canal, see “Changing Object Color and Line Thickness”.
In the **Implants** window, do any of the following:

<table>
<thead>
<tr>
<th>To resize the implant...</th>
<th>Configure the following dimensions:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Catalog Length</strong>: The length of the implant platform from the head to the apex.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Head Length</strong>: The length of the implant head.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Head Diameter</strong>: The diameter of the implant head.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Diameter</strong>: The diameter of the implant platform.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Apical Diameter</strong>: The diameter of the apex.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To move the implant...</th>
<th>Click on the implant. The pointer changes to <code>(shift)</code>. Drag the implant to a new position.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image" alt="Diagram of implant movement" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To rotate the implant...</th>
<th>Move the mouse pointer over one of the implant’s rotation grab handles. The pointer changes to <code>##</code>. Click on a rotation grab handle (A) and drag around the centre of the implant object. The implant object is rotated. As the object rotates, the centre of rotation is indicated by a “+” (B).</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image" alt="Diagram of implant rotation" /></td>
</tr>
</tbody>
</table>

**Using the Undo and Redo Functions**

You can find the **Undo** and **Redo** functions in the **Drawings & Annotations** toolbar. See “Using the Drawings & Annotations Toolbar”.

The following characteristics apply to the **Undo** function:

- In the **Image Viewing Workspace**, an **Undo** affects only to selected images. In the **Darkroom** mode, **Undo** affects only to the image currently being viewed.
- **Undo** applies only to actions in the **Drawings & Annotations** toolbar. It does not apply to actions performed using other toolbars.
- You can undo up to a maximum of 50 operations.

You can use the **Redo** function to counteract the **Undo** function.

**Deleting Drawing Objects**

To delete drawing objects on images, follow these steps:
1. Open the image in the **Image Viewing Workspace** or **Darkroom** mode.

2. In the **Drawings & Annotations** toolbar, click .

3. In the image, do one of the following:

   - Hover the mouse pointer over the object you want to delete. When the pointer changes to , click to select the object. The selected object appears with square grab handles.

   ![Image of an object with square grab handles]

   - Click and drag over the objects. An area selection box (A) appears.

   ![Image of an area selection box (A)]

   - Use Ctrl + click to select the objects you want to delete.

4. When all the objects that you want to delete are selected, do one of the following:

   - Click in the **Drawings & Annotations** toolbar.
   - Press the **Delete** key on your computer.

**Changing Object Color and Line Thickness**

To change object color and line thickness, follow these steps:

1. Open the image in the **Image Viewing Workspace** or **Darkroom** mode.

2. In the **Drawings & Annotations** toolbar, click .

3. In the image, move the mouse pointer over the object you want to edit. The pointer changes to .

4. Click to select the object. The selected object appears with square grab handles.

5. In the **Drawings & Annotations** toolbar, click .
The **Color and Line Thickness** window appears.

6 In the **Color and Line Thickness** window, do any of the following:
   - Click on the color picker square to select a different color.
   - Select a line thickness from the drop-down list.

7 Click **Apply**.

**Moving and Resizing an Object**

To move and resize objects, follow these steps:

1 Open the image in the **Image Viewing Workspace** or **Darkroom** mode.

2 In the **Drawings & Annotations** toolbar, click .

3 In the image, move the mouse pointer over the object you want to move or resize.

   The pointer changes to .

4 Click to select the object.

   The selected object appears with square grab handles.

5 Click on the object to move it, or click on a square grab handle to resize it.

**Rotating an Object**

To rotate an object, follow these steps:

1 Open the image in the **Image Viewing Workspace** or **Darkroom** mode.

2 In the **Drawings & Annotations** toolbar, click .

3 In the image, move the mouse pointer over the object you want to rotate.

   The pointer changes to .

4 Click on the object to display square grab handles.

5 Click a second time on the object to display green rotation grab handles.

6 Move the pointer over a green rotation grab handle.
The mouse pointer changes to \( \text{\textcircled{a}} \).

7 Click on the rotation grab handle and drag the object to a new position.

The selected object is rotated. As the object rotates, the centre of rotation is indicated by a "\( + \)".

### Changing the Stack Order

When you draw objects on an image, they are arranged in a stack order, so that sometimes an object will be displayed on top of, or beneath another object.

![Stack Order Diagram]

- **A** The green circle is behind the other two objects.
- **B** The green circle is between the other two objects.
- **C** The green circle is on top of the other two objects.

To change the stack order, follow these steps:

1. Open the image in the **Image Viewing Workspace** or **Darkroom** mode.

2. In the **Drawings & Annotations** toolbar, click \( \text{\textcircled{a}} \).

3. In the image, move the mouse pointer over the object you want to reorder.

   The pointer changes to \( \text{\textcircled{a}} \).

4. Click on the object to display square grab handles.

5. Right-click on the selected object, and from the contextual menu, select one of the following.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bring to front</strong></td>
<td>The object is moved to the front of the stack.</td>
</tr>
<tr>
<td><strong>Send to back</strong></td>
<td>The object is moved to the backwards of the stack.</td>
</tr>
<tr>
<td><strong>Bring forward</strong></td>
<td>The object is moved forwards one place in the stack.</td>
</tr>
<tr>
<td><strong>Send backward</strong></td>
<td>The object is moved backwards one place in the stack.</td>
</tr>
</tbody>
</table>
Using Measurements to Calculate Distances and Angles

**WARNING:**
- All image measurements are indicative only. Measuring and positioning tasks are carried out under your own responsibility.
- For accurate measurements, images must be calibrated using a reference object of known length.
- For panoramic images, calibration and measurement are reliable only around the reference objects of known length.

You can use measurements to calculate the distances or angles between points on an image.

**Important:** A radiological image is a two dimensional image of a three dimensional object, and measurements may be subject to errors. It is recommended that you do measurements or drawings with pre-determined length values only on calibrated images. Doing this on an image with no calibration information requires use of a reference segment of known length.

The typical order of tasks is the following:

1. “Calibrating an Image”.
2. “Making Measurements”.

**Calibrating an Image**

In order for CS Imaging to calculate measurement values accurately, the image must be calibrated. The calibration state of an image is shown by the following icons in the bottom left hand corner of the image.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Image has been calibrated. All measurements are calculated relative to the image calibration.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Image has not been calibrated. The image must be calibrated before measurements are taken.</td>
</tr>
</tbody>
</table>

**Note:**
- To calibrate a measurement, the image must contain a reference segment of a known length.
- Calibration is only necessary if it was not done previously. When using cephalometric images generated by hardware such as the CS 8000C, CS 9000C, CS 8100SC, CS 8100 SC 3D, or CS 9300C, most of the images are automatically calibrated and no manual calibration is needed. For the few images that are not automatically calibrated, a warning message requesting it appears.

To calibrate an image, follow these steps:

1. Open the image in the Image Viewing Workspace or Darkroom mode.
2. In the Drawings & Annotations toolbar, click

---

68
The **Calibration** panel appears.

3. On an image, click one end of a reference segment of known length.

4. Move the cursor to the second end point of the reference segment, and double-click.

   A line segment appears with a length. The length is also displayed in the **Calibration** calculator window.

5. Do one of the following:
   - If the displayed value corresponds to the known length, in millimeters, of the object, click .
   - If not, click  and enter the correct value. You can use your computer’s number keys or click the number keys on the calculator to enter the value.

   When you have changed the value, click . You will be asked to confirm the change. Click **Yes**.

**Making Measurements**

A measurement can show, for example, the distance between two points in an image.

---

**Tip:**
- To check the units of measurement, hold your mouse pointer over the annotation. A tooltip appears (see image above) that displays details about the annotation.
- To manage annotations (show/hide, change colors, delete, display values/units), you can display the list of measurements. See “Using the Screen Options”.

---

**Note:** Units of measurement are Standard International (SI) units, millimeters (mm) for length and degrees (°) for angles.

---

The following types of measurements are available in the **Drawings & Annotations** toolbar in the **Measurements** icon group:

- Straight line measurement
- Multi-segment line (Polyline) measurement
- Angle
To add a measurement to an image, follow these steps:

1. Open the image in the Image Viewing Workspace or Darkroom mode.

2. In the Drawings & Annotations toolbar, in the Measurement icon group, select one of the following.

   **Tip:** You can show or hide measurements using the Display Measurements option in the Screen Options menu.

### To draw a straight line measurement...

1. Click 
2. On the image, click to set the beginning and end points of the line. The line appears with its measurement (in millimeters).

### To draw a multi-segment line (polyline) measurement...

1. Click 
2. On the image, click to set the start point.
3. Move the mouse pointer to the first intermediate point of the line, and click again. A line segment appears with its measurement (in millimeters).
4. Repeat step 3 to create as many segments as you want.
5. Double-click to create the final endpoint. Measurements are displayed for each segment of the polyline. The total length appears in the tooltip and measurements list.

### To draw an angle measurement...

1. Click 
2. On the image, click to create the start point of your angle (A).
3. Click to set the midpoint (B). A line appears.
4. Click to set the end point (C). A second line appears, with the angle between the two lines shown in degrees. The angle is automatically calculated and displayed on the image and in the measurements list.

The sequence of clicks for drawing angles is shown below.
Modifying and Deleting Measurements

To edit or delete a measurement using the Selection tool, follow these steps:

1. Open the image in the Image Viewing Workspace or Darkroom mode.

2. In the Drawings & Annotations toolbar, click .

3. Do one or more of the following:
   - To move a measurement, click and drag it.
   - To change the line color or thickness, see “Changing Object Color and Line Thickness”.
   - To move control points on a measurement line or angle, click and drag it.
   - To delete the measurement, see “Deleting Drawing Objects”.

Using the Measurements List in the Image Viewing Workspace or Darkroom Mode

By default, when you activate a measurement tool or display an image that contains measurements, the measurements list appears automatically. This list can display one of the following:

- Cephalometric measurements
Manual measurements

Tip: You can select a measurement using the Select tool on the Drawings & Annotations toolbar. See "Using the Drawings & Annotations Toolbar".

The measurements list includes the following features.

<table>
<thead>
<tr>
<th></th>
<th>Measurements list toolbar</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>The toolbar contains the following tools:</td>
</tr>
<tr>
<td></td>
<td>- Click to access the cephalometric measurements and settings. To work with these settings, see &quot;Working with Cephalometric Automatic Tracings&quot;.</td>
</tr>
<tr>
<td></td>
<td>- Click to access manual measurements.</td>
</tr>
<tr>
<td></td>
<td>- Click to close the measurements list.</td>
</tr>
<tr>
<td></td>
<td>Tip: You can also close the list by deselecting Display Measurements in the Screen Options menu.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Image acquisition date</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Visibility of manual measurement in image</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>- Indicates that the manual measurement is visible in the image.</td>
</tr>
<tr>
<td></td>
<td>- Indicates that the manual measurement is not visible.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Color of manual measurement in image</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>To change the color of the measurement represented in the row, click the color box for the measurement.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Manual measurement length</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Delete icon for manual measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td>To delete a manual measurement, click .</td>
</tr>
<tr>
<td></td>
<td>Note: When you delete all measurements, or the last single measurement remaining in the window, you will be asked to confirm if you want to delete all measurements.</td>
</tr>
</tbody>
</table>

Using the Zoom Tool

When you magnify an image in the Image Viewing Workspace or Darkroom mode, you can see small details of the image. You can magnify the entire image or magnify a localized area of the image using the Zoom tool.

To use the Zoom tool, follow these steps:

1. View the image in the Image Viewing Workspace or Darkroom mode.

2. In the Image toolbar, click .

   When you move the mouse pointer over the image, the pointer appears as a magnifying glass .
3 Click on the image to display a circular magnified region.

4 Drag the region over the image to magnified a specific area.

5 Hold down the mouse button, and drag the pointer over the image to move the magnified region around.

You can increase or decrease the level of magnification and the size of the magnified region using the Zoom sliders.

6 To access the Zoom sliders, click the white triangle on the lower corner of the button.

7 To turn off the Zoom tool, click .

### Using the Highlight Tool

You can use the Highlight tool to focus on parts of an image by reinforcing pixel contrast.

This tool is useful for investigating interproximal areas and detecting caries and fractures. Contrast values are optimized according to the available grayscale.

To highlight an area of interest, follow these steps:

1 Select the image in the Image Viewing Workspace or Darkroom mode.

2 In the Image toolbar, click .

The Highlight window appears.

3 In the image window, move the mouse pointer over the image.

   The pointer changes to .

4 Select the region you want to highlight.

   A circular highlight region appears on the image.

5 Click and drag the pointer to highlight another region in the image.

   To increase or decrease the size of the highlight region, click the white triangle in the lower corner of the Highlight icon to access the Highlight slider.

6 To turn off the Highlight tool, click .
Using the Color Tools

CS Imaging provides two color filters that convert grayscale pixels into colored pixels.

You can use these filters, available in the Image toolbar, to help identify and isolate specific regions of the image when making a diagnosis.

<table>
<thead>
<tr>
<th>Colors #1</th>
<th>Maps pure black to blue and pure white to red; other shades of gray are mapped on the image based on intermediate colors on the standard color wheel.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colors #2</td>
<td>Maps middle-gray to orange and leaves pure black and pure white in their original states; other shades of gray are mapped to yellow as they move toward white and to brown as they move toward black. The result is an image displayed in colors similar to sepia tones.</td>
</tr>
<tr>
<td>Grayscale</td>
<td>Maps colors to grays.</td>
</tr>
</tbody>
</table>

To apply a colors scheme to an image, follow these steps:

1. Select the image in the Image Viewing Workspace or Darkroom mode.
2. In the Colors icon group, click a colors icon.

   **Note:** If a white triangle appears in the lower corner of the icon, then you access to the different tools in the icon group. See "Using Icon Groups".

The selected image appearance changes based on the icon you selected.

To restore the original image colors, click again on the Colors icon.

Cropping Images

In the Image toolbar, in the Density icon group, you can use the Crop image tool to temporarily hide unwanted space around a selected area.

**Note:**
- The Crop image tool only alters the image view. It does not modify the image file.
- A cropped image has displayed in the bottom corner.
- If a white triangle appears in the lower corner of the icon, then you access to the different tools in the icon group. See "Using Icon Groups".

To crop an image, follow these steps:

1. Select the image in the Image Viewing Workspace or Darkroom mode.
2. In the Image toolbar, in the Density icon group, click .

   A white border with handles appears on the image, and the Crop panel appears.
3. In the selected image, click and drag one or more handles to the desired location.
4. In the Crop panel, do one of the following:
• Click to accept your crop and close the tool.

• Click to cancel the crop, close the tool, and leave the image in its current state.

• Click to reset all previous crops and return to the image’s original format.

**Using the Isodensity Tool**

You can use the **Isodensity** tool to identify those parts of an image of similar density. Up to three different density levels can be displayed at the same time. The **Isodensity** tool helps to enhance the views of the tooth enamel, dentin, and pulp.

If the case of pathology, the difference in density can be shown in comparison to a healthy area.

You can also use the **Isodensity** tool to verify the integrity of an implant by analyzing the structure of the bone around the implant.

**Important**: Because a radiographic image is a two-dimensional image of a three-dimensional object, density estimations are subject to error.

To show regions of similar density in an image, follow these steps:

1. Select the image in the **Image Viewing Workspace** or **Darkroom** mode.

2. In the **Image** toolbar, in the **Density** icon group, click .

   **Note**: If a white triangle appears in the lower corner of the icon, then you access to the different tools in the icon group. See “Using Icon Groups”.

The **Isodensity dots** window appears.

3. Move the mouse pointer over the image.

   The mouse pointer changes to .

4. In the image, click on a pixel point.

   All points in the image with similar color density are displayed in the first color.
The density value of your selection appears alongside the first color picker box (A).

5 Click on a second pixel point.
All points in the image with similar color density are displayed in the second color.

6 Click on a third pixel point.
All points in the image with similar color density are displayed in the third color.

Note: You can select up to three densities at the same time. Each density appears in a different color. The density value associated with each color is shown in the Isodensity dots window (A).

7 You can also do any of the following:

- To change a color associated with a point, click the color box (B) that you want to change. In the Color window, select a new color and click OK.

- To adjust the sensitivity of the pixel ranges selected, move the slider (C) to the left to reduce pixels, and to the right to increase pixels.

- To reset the Isodensity settings, click .

8 To switch off the Isodensity function, in the Isodensity dots window click OK.

Using the Densitometric Analysis Tool

The Densitometric Analysis tool in the Density icon group allows you to analyze the relative density of tissue along a plotted section.

This grayscale allows you to compare two points on the same image. This is particularly useful for osteo-integration after an implant has been fitted.

You can also determine if a darkened area is an apical area, indicating a difference in the density of the bone in that area.

Tip: To view the ideal bone density for a patient, perform an analysis at the dentin-enamel junction and redo the analysis at the patient's real bone level.

To analyze image density, follow these steps:
1 Select the image in the **Image Viewing Workspace** or **Darkroom** mode.

1 In the **Image** toolbar, in the **Density** icon group, click ![Density icon](image).

   **Note:** If a white triangle appears in the lower corner of the icon, then you access to the different tools in the icon group. See “Using Icon Groups”.

The **Densitometric Analysis** window appears.

2 Draw a section line on the image by clicking and dragging from an initial point and releasing at another point.

3 To establish the grayscale value at a given point along the line, click and drag the dot (A) along the plotted line until it is positioned over the required point.

   ![Densitometric Analysis window](image)

   The position of the dot is plotted continuously along the graph (B) in the **Densitometric Analysis** window. The X and Y coordinates are shown (C). The value of the grayscale at the selected point is shown.

4 To clear and start new measurements of point values, click ![Clear](image) (D).

5 To close the window, click **OK**.

   **Note:** If you apply a filter or effect to the image, the **Histogram** is updated automatically with the grayscale of the selected pixel.

   **Important:** The grayscale values obtained using the Densitometric Analysis tool do not represent actual bone density values and are dependant on image contrast.

**Using Pseudo 3D**

Use **Pseudo 3D** in the **Filter** icon group to display a three-dimensional representation of a 2D image at a 45° angle and in different shades of gray.
**Pseudo 3D** is useful for showing furcation involvement, periapical cysts, vertical fractures, and a variety of other difficult-to-diagnose situations.

<table>
<thead>
<tr>
<th>Original Image</th>
<th>Pseudo 3D Rendering</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Original Image" /></td>
<td><img src="image2" alt="Pseudo 3D Rendering" /></td>
</tr>
</tbody>
</table>

Important: This tool does not create a true 3D reconstruction of the image. It is only an aid to visualizing the existence of certain conditions.

To use pseudo 3D display, follow these steps:

1. Select the image in the **Image Viewing Workspace** or **Darkroom** mode.
2. In the **Image** toolbar, in the **Filter** icon group, click ![Filter Icon](image3). The image appears as a pseudo 3D image.
3. Click ![Pseudo 3D Off Icon](image4) to turn off **Pseudo 3D**.

**Using Negative Images**

You can view an image as a photo negative, for example, in endodontics, when you want to highlight the end of a file near the apex.

The negative image enables the file to be clearly distinguished from the apical information, whereas a positive image can cause confusion due to the fact that the grayscale is similar.

To display an image as a photo negative, follow these steps:

1. Select the image in the **Image Viewing Workspace** or **Darkroom** mode.
2. In the **Image** toolbar, click ![Negative Image Icon](image5).
The image appears as a photo negative.

3. To revert to the original image, click .

The image is restored to normal mode.

**Using Cephalometric Automatic Tracings**

Important:
- Cephalometric automatic tracings are intended to support, but not replace, diagnosis. The accuracy of the tracings is approximate and may require adjustments to be made.
- To use cephalometric automatic tracing, you must have the Trace module installed. If the icon is not available in the Image toolbar, then you need to re-run the installation CD and select Trace.
- This feature can be used on cephalometric images acquired from the following machines:
  - CS 9000, CS 9300, and CS 9300 Select
  - CS 8100 and CS 8100 3D families

The dental malocclusion calculations are divided in three classes:

- Class I (tooth problems)
- Class II (retrognathism or overbite)
- Class III (prognathism or negative overjet)

**Creating a Cephalometric Automatic Tracing**

To create a cephalometric tracing, follow these steps:

1. View a cephalometric image in the Image Viewing Workspace or Darkroom mode.

   Important: Before launching the calculation, make sure that your image is a cephalometric lateral image. Otherwise, the calculation will not work.

2. In the Drawings & Annotations toolbar, click to launch the Cephalometric Tracing calculation.

   Important:
   - If this icon is not available, you need to re-run the installation CD and select Trace.
   - The first time you launch the calculation, a caution message warns you about your responsibility to analyze, interpret and determine the validity of the automatic tracings. If you agree, click OK.

A wheel appears while the tracings are being calculated. Depending on the power of your computer processor, this can take a while.

Once the calculations are complete, the original cephalometric image appears with the new tracings, and you can access the cephalometric list in the Measurements list. See “Using the Measurements List in the Image Viewing Workspace or Darkroom Mode”.

In the Measurements list, you can select a different template, check the tracing structures, landmarks, measurements, and generate a report.
Working with Cephalometric Automatic Tracings

To modify cephalometric automatic tracings template, follow these steps:

1. View a cephalometric image in the Image Viewing Workspace or Darkroom mode.

2. Click 📈, then select Display Measurements to activate the Measurements list.
   
   See "Using the Measurements List in the Image Viewing Workspace or Darkroom Mode".

3. In the Measurements list, click 📈.

4. Do any of the following:

<table>
<thead>
<tr>
<th>To change the template for the automatic tracings...</th>
<th>From the drop-down list, select a different template.</th>
</tr>
</thead>
<tbody>
<tr>
<td>To generate a report...</td>
<td>Click the Generate Report button to generate a report of your cephalometric tracing. This generates a report as an HTML file which you can view and print from your browser.</td>
</tr>
<tr>
<td>To automatically recalculate all of the other related points, lines and structures...</td>
<td>Click Dynamically update.</td>
</tr>
<tr>
<td>To show the structure points (A)...</td>
<td>Click Show structures to show the points.</td>
</tr>
<tr>
<td>To show the landmark points (B)...</td>
<td>Click Show landmarks.</td>
</tr>
<tr>
<td>To show the cephalometric axis and plane lines (C)...</td>
<td>Click Show measurements.</td>
</tr>
</tbody>
</table>

Modifying Tracings

Once a cephalometric tracing has been calculated and drawn onto a cephalometric image, you can manually modify a tracing in the image.

Important: If you have selected Dynamically update in the Measurements list and you modify a tracing directly on the cephalometric image, then the Undo (Ctrl + Z) tool is unavailable.

To modify the tracing on a cephalometric image, follow these steps:
1 View the cephalometric image in the **Image Viewing Workspace** or **Darkroom** mode.

2 In the **Drawings & Annotations** toolbar, click ![cursor](image)

3 Select a tracing element.
   
   Drawing handles appear.

4 Click and drag different points of the drawing.

---

**Important:**

- Moving an object with links to other objects moves all related objects.
- If you have selected *Dynamically update* in the *Measurements* list and you modify a tracing directly on the cephalometric image, then the Undo (Ctrl + Z) tool is unavailable.

---

**User-Defined Landmark Points**

Any user-defined landmark points are displayed in the tracing as ![landmark](image).

If your tracing contains measurement elements that refer to user-defined landmark points, the measurement value in the measurements list appear as **N/A**.

---

**Note:** If the measurements list is not visible in the **Image Viewing Workspace** or **Darkroom** mode, you can activate it in the **Screen Options** menu.

---

To display the true measurement value referencing a user-defined landmark point, follow these steps:

1 In the **Drawings & Annotations** toolbar, click ![cursor](image)

2 Click ![landmark](image) on the cephalometric tracing.
   
   The landmark point changes to ![calculation](image) and the measurements list shows a calculated value.

---

**Using the Tracings Editor**

In the **Tracings Editor**, you can customize automatic tracings and define your own template.

To display the **Tracings Editor**, follow these steps:

1 In the **Image Viewing Workspace** or **Darkroom** mode, close all cephalometric images.

2 In the **CS Imaging** task bar, click ![preferences](image).
   
   The **Preferences** window appears.

3 In the **Preferences** window, click ![chat](image).

4 Click **Tracings Editor**.
The Tracings Editor window appears, displaying a list of predefined templates and the following tabs.

<table>
<thead>
<tr>
<th>Landmark Structure</th>
<th>Contains areas for automatic landmarks and structures, and user-defined points.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measurement</td>
<td>Contains areas for the measurement label with its parameters, and an area for the axis and planes parameters.</td>
</tr>
</tbody>
</table>

5 To view the corresponding automatic landmarks, automatic structures, and measurements, select the one of the following:

- Default (default template)
- Delaire (available for all versions)
- McNamara (method)
- Ricketts (method)
- Steiner (method)
- Tweed (method)

**Important:** You cannot edit a pre-defined template, but you can create your own template by copying a pre-defined one.

Creating a Template

To create a template, follow these steps:

1. In the **Image Viewing Workspace** or **Darkroom** mode, close all cephalometric images.

2. In the **CS Imaging** task bar, click .
   The Preferences window appears.

3. In the **Preferences** window, click .

4. Click **Tracings Editor**.

5. In the **Tracings Editor** window, click **New Template**.

6. Enter a name for the template in the **New ceph tracings template** window and click **OK**.
   By default, parameters are displayed without measurements.

7. In the **Landmark Structure** tab, click **** to activate landmark structures for the new template.
   This will change active landmark structures to ****.

8. If required, add additional structure points by clicking **** , and then click anywhere in the sample cephalometric image to enter the name of your new landmark point.

9. In the **Measurement** tab, click **** to activate measurements for the new template.
   This will change active measurements to ****.
10 If required, add additional measurements by clicking .
   In the **New Measurement** window, define the new measurement entry and click **OK**.

11 When you have finished creating your template, click **Save**, then **Close**.

### Copying a Template

To copy a template, follow these steps:

1 In the **Image Viewing Workspace** or **Darkroom** mode, close all cephalometric images.

2 In the **CS Imaging** task bar, click .
   The **Preferences** window appears.

3 In the **Preferences** window, click .

4 Click **Tracings Editor**.

5 In the **Tracings Editor**, select the template you want to copy and click **Copy template**.

6 Enter a template name and click **OK**.
   Existing **Landmark Structure** and **Measurement** details from the source method template are displayed.

7 On the **Landmark Structure** tab, click the  icon to deactivate any **Automatic landmarks** you do not want to use.

8 On the **Measurement** tab, click the  icon to deactivate any the **Measurements** and **Axis and Planes** details you do not want.

9 If required, add additional measurements by clicking .
   In the **New Measurement** window, define the new measurement entry and click **OK**.

10 When you have finished creating your template copy click **Save**, then **Close**.

### Managing Landmark Structures

In the **Landmark Structure** tab of the **Tracings Editor**, you can manage the automatic and user-defined structures that a tracings template uses to create a cephalometric tracing.

The **Landmark Structure** tab is divided into three collapsible sections.

<table>
<thead>
<tr>
<th><strong>Automatic landmarks</strong></th>
<th>This section contains all automatic landmark elements on the tracing.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automatic structures</strong></td>
<td>This section contains all automatic structure elements on the tracing.</td>
</tr>
<tr>
<td><strong>User-defined points</strong></td>
<td>This section contains all user-defined point elements on the tracing.</td>
</tr>
<tr>
<td><strong>Note:</strong> This section may be empty if the template does not contain any user-defined points.</td>
<td></td>
</tr>
</tbody>
</table>
Each element has a color assigned to it. To change the color, click and choose the new color.

**Note:** If a section contains many elements, the lower sections may be hidden from view and you may need to scroll down to see them. To collapse a long section, click the double arrow icon ( ) to the right of the section name. A collapsed section can be expanded again by clicking the double arrow icon ( ).

### Managing Cephalometric Measurements

In the **Measurement** tab of the **Tracings Editor**, you can manage the **Measurement** and **Axis and Planes** elements that a template uses to create a cephalometric tracing.

The **Measurement** tab is divided into two collapsible sections.

<table>
<thead>
<tr>
<th>Measurements</th>
<th>This section contains all measurement elements on the tracing.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>The Measurements section may be empty if the template does not contain any measurement elements.</td>
</tr>
<tr>
<td>Axis and Planes</td>
<td>This section contains all the Axis and Planes elements on the tracing.</td>
</tr>
</tbody>
</table>

Each element has a color assigned to it. To change the color, click and choose the new color.

**Note:** If the Measurements section contains many elements, the Axis and Planes section may be hidden from view and you may need to scroll down to see it.

To collapse a long section, click the double arrow icon ( ) to the right of the section name. A collapsed section can be expanded again by clicking the double arrow icon ( ).

### Resetting Images

In the **Image Viewing Workspace** or **Darkroom** mode, you can reset the following image settings on one or more selected images, even if you have already saved the image modifications:

- Brightness, contrast, and gamma adjustments in the **Control Panel**
  
  See "Adjusting Image Brightness, Contrast and Gamma in 2D Images".

- The following **Image** toolbar functions:
  - **Negative**
  - **Colors #1**
  - **Colors #2**

To reset a single image, click in the image title bar.

To reset a selection of two or more images, do one of the following:

- Click to display the **Control Panel** and in the **Image Processing** tab, click .
- Right-click one of the selected images and select **Reset Image**.
Using FMS

An FMS (Full Mouth Series) is a complete set of intraoral radiographic images taken of a patient’s mouth.

The FMS system provides templates that enable you to associate a patient's intraoral images with specific regions of the mouth. FMS templates are comprised of frames that correspond to regions of the mouth. Intraoral images can be mapped to specific regions of a patient’s mouth by placing them in the appropriate frames.

There are several predefined FMS templates available within CS Imaging. See “Using a Predefined FMS Template”.

You can also create your own FMS template. See “Creating a Template in the FMS Editor”.

Once you have mapped patient images using an FMS template, you can save the mapping as an FMS entity for future reference in the Patient History.

FMS templates are managed and created in the FMS Editor, which you can access in the “Template Preferences”.

Using a Predefined FMS Template

FMS templates enable you to track digital intraoral radiographic images. Each box (or frame) in an FMS template corresponds to a region of the mouth. As you acquire images, you can associate them with a specific region until you have obtained all the images needed to complete the FMS.

There are several predefined FMS templates available within CS Imaging to suit the way you work. Should the need arise, CS Imaging also enables you to create your own FMS template.

To use an FMS template, follow these steps:

1. In the Image Viewing Workspace or Darkroom mode, click the Screen Options icon and select New Image Template.
   A window appears in which you can choose an FMS template.

2. Select an FMS template.
   It appears the Preview pane.

3. If you want to use the selected template, click Open.

4. Add images to frames in the FMS. See “Adding Images to an FMS”.

Opening an Existing FMS Image

To view a saved FMS, in the Patient History (Patient Browser or Dashboard) or Image Gallery (Image Viewing Workspace or Darkroom mode), double-click on its thumbnail.

The following happens:
If you’re opening the FMS from the Patient History or Image Gallery in the Image Viewing Workspace, the FMS appears in the Image Viewing Workspace.

If you’re opening the FMS from the Image Gallery while the Darkroom mode, the FMS appears in the Darkroom.

Adding Images to an FMS

To add an image to an FMS, follow these steps:

1. Open an FMS in the Image Viewing Workspace or Darkroom mode.

2. Click to view the Image Gallery.

3. Click an image in the Image Gallery, hold the mouse button down and drag the mouse pointer over one of the FMS cells.

   The mouse pointer changes to.

4. Release to drop the image.

   If the image can be added to the FMS it is displayed in a frame in the FMS.

   Note:
   • If the image cannot be added to the FMS and is displayed in its own window, check that you are adding the correct image type to the FMS.
   • If the image appears in a different frame in the FMS, it is because the image has been associated with the tooth number associated with that frame; image are automatically added to a frame in the FMS that matches its tooth number.
   • If a portrait image is added to a landscape frame, the image will be automatically rotated in the FMS.
   • If you move images from top to bottom or right to left, depending on where the median axes are positioned in the template, the images are automatically flipped.

5. Repeat the drag and drop action as necessary.

6. To select multiple images in the FMS template, click in the top right-hand corner of the FMS title bar.

   Note: Additionally, when multiple images are selected, they can be simultaneously adjusted:
7 When you are done, in the image title bar, click (Image Viewing Workspace) or (Darkroom mode).

The Save FMS window appears.

8 In the Save FMS window, enter your FMS configuration details. See “Setting FMS Configuration Details in the Save FMS Window”.

9 Click Save.

Note: If a portrait image is added to a landscape frame, the image will be automatically rotated in the FMS.

---

Setting FMS Configuration Details in the Save FMS Window

You can set FMS configuration details in the Save FMS window.

<table>
<thead>
<tr>
<th>FMS thumbnail</th>
<th>In this thumbnail preview, you can select images in the FMS. As you click on an image, the image’s tooth mapping window in the Teeth panel.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>This displays the date that the FMS was created.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enter comments in this field. (Optional)</td>
</tr>
<tr>
<td>Note: To edit these comments at a later stage, open the FMS again and in the image title bar, click (Image Viewing Workspace) or (Darkroom mode) to redisplay the FMS Save window.</td>
<td></td>
</tr>
<tr>
<td>Dental Arch</td>
<td>The Dental Arch panel displays the patient teeth.</td>
</tr>
<tr>
<td></td>
<td>When you click on an image in the FMS thumbnail, the image’s tooth number is represented on this arcade as a blue tooth.</td>
</tr>
<tr>
<td></td>
<td>The actual tooth numbers are displayed below the arcade.</td>
</tr>
<tr>
<td></td>
<td>Click to change the display to Deciduous (child) dentition.</td>
</tr>
<tr>
<td></td>
<td>Click to change the display to Permanent (adult) dentition.</td>
</tr>
<tr>
<td>Bitewing selection</td>
<td>Select to define the following bitewing location options:</td>
</tr>
<tr>
<td>not a bitewing</td>
<td>Click to specify that the image you have added is not a bitewing.</td>
</tr>
<tr>
<td>LM</td>
<td>Bitewing Location: Left Molar</td>
</tr>
<tr>
<td>RM</td>
<td>Bitewing Location: Right Molar</td>
</tr>
<tr>
<td>RMP</td>
<td>Bitewing Location: Right Molar and Premolar</td>
</tr>
<tr>
<td>LMP</td>
<td>Bitewing Location: Left Molar and Premolar</td>
</tr>
<tr>
<td>LP</td>
<td>Bitewing Location: Left Premolar</td>
</tr>
<tr>
<td>RP</td>
<td>Bitewing Location: Right Premolar</td>
</tr>
</tbody>
</table>

---

Removing Images from an FMS

You can remove an image from an FMS without deleting the image from the Patient Card.

To remove an image from an FMS, follow these steps:

1 Open an FMS in the Image Viewing Workspace.
2 Click and drag the image out of the FMS to the workspace.
The image is displayed in its own window and removed from the FMS frame.

3 In the FMS image title bar, click .

The Save FMS window appears.

4 In the Save FMS window, enter your FMS configuration details. See “Setting FMS Configuration Details in the Save FMS Window”.

5 Click Save.

Using the FMS Editor

In the CS Imaging FMS Editor, you can create custom FMS templates from scratch or by customizing existing templates in the FMS Editor.

FMS Editor Toolbar Buttons

The FMS Editor, accessible from the Template preferences window, offers the following icons.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Open and modify an existing FMS template.</td>
</tr>
<tr>
<td>Save</td>
<td>Save a new template.</td>
</tr>
<tr>
<td>Insert</td>
<td>Insert a frame of the same size and orientation as the last one selected.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy the selected frame. This button is grayed out until a frame is selected in the template.</td>
</tr>
<tr>
<td>Paste</td>
<td>Paste a copied frame into the template. This button is grayed out until a frame has been copied.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the selected frame. This button is grayed out until a frame is selected in the template.</td>
</tr>
<tr>
<td>Numbering</td>
<td>Display or change the acquisition order of the frames. You can customize the number of each frame.</td>
</tr>
</tbody>
</table>

FMS Toolbox Buttons

The FMS Editor, accessible from the Template preferences window, offers a toolbox containing tools to insert and align objects and configure frame properties. To display the FMS Editor Toolbox, select View > Toolbox.
The **Tools** tab of the **Toolbox** contains the following buttons.

<table>
<thead>
<tr>
<th>Insert buttons</th>
<th>Horizontal radiographic</th>
<th>Horizontal IO CAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each of these buttons will insert a frame into your FMS template.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The numeric value is an indication of the frame's relative size (for example a horizontal radiographic 3 frame is larger than a horizontal radiographic 2 frame).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use frames that match the image types that you want to use in the FMS.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>For example, if your FMS template does not include a camera frame, you will not be able to add color images to the FMS.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Align</strong> buttons</td>
<td>Vertical radiographic</td>
<td>Vertical IO CAM</td>
</tr>
<tr>
<td>Each of these buttons will align a selection of frames in your FMS template.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>In the <strong>FMS Editor</strong>, use Ctrl+click to select multiple frames before clicking an <strong>Align</strong> button.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Creating a Template in the FMS Editor

To create an FMS template, start by considering the following FMS frame details:

- Image size
- Image orientation (portrait or landscape)
- Default tooth number

To create an FMS template, follow these steps:

1. In **CS Imaging**, click 🛠️. The **Preferences** window appears.
2. Click 📝.  
3. Click **FMS Editor**. The **Manage** FMS window appears.
4. Click **Create**. The **FMS Editor** appears.
5. To customize the new FMS template, any of the following:
when your new template is complete, select \texttt{File > Save As} or \texttt{File > Save} in the FMS Editor to save your new template. The \texttt{Save} window appears.

7 Enter a name for the template.

8 Click \texttt{OK}.

\textbf{Customizing an Existing FMS Template}

To can create a FMS template based on an existing predefined or custom FMS template, follow these steps:

1 In \texttt{CS Imaging}, click \texttt{ }.
   
   The \texttt{Preferences} window appears.

2 Click \texttt{ }.

3 Click \texttt{FMS Editor}.
   
   The \texttt{Manage} FMS window appears.

4 Select the template you want to modify and click \texttt{Modify}.
   
   This opens the selected template for edit in the FMS Editor.

5 In the FMS Editor, modify the FMS template as required:
   
   \begin{itemize}
   \item “Inserting an Image Frame”
   \item “Inserting a Preview Frame”
   \item “Using the Axes to Orient Images”
   \item “Aligning a Frame”
   \item “Assigning Default Tooth Numbers”
   \item “Assigning or Modifying Acquisition Order in an FMS Template”
   \end{itemize}

6 In the FMS Editor, select \texttt{File > Save As} to save the modified template with a new name.
Inserting an Image Frame

In the FMS Editor, you can insert horizontal and vertical frames into a template.

Note: Image frame sizes are fixed and cannot be resized.

To insert an image frame into an FMS template, follow these steps:

1. In CS Imaging, click .

   The Preferences window appears.

2. Click .

3. Click FMS Editor.

   The Manage FMS window appears.

4. Click Create or Modify.

   The FMS Editor appears.

5. To insert an image frame into a template, do one of the following:

   - In the FMS Editor menu bar, select View > Toolbox. In the Toolbox window, click on an Insert button to insert a frame into the template.

   - In the FMS Editor menu bar, select Tools > Insert. Select a frame type.

   The selected image frame is automatically positioned on the template.

6. Move and resize the image frame as necessary.

7. When you have completed your changes, select File > Save.

   The Save window appears.

8. Click OK.

Inserting a Preview Frame

To insert a preview frame in an FMS template, follow these steps:

1. In CS Imaging, click .

   The Preferences window appears.

2. Click .

3. Click FMS Editor.

   The Manage FMS window appears.

4. Click Create or Modify.

   The FMS Editor appears.

5. If the Toolbox is not visible, select View > Toolbox.
6 In the **Tools** tab, click ![icon](image).

A preview frame is placed at the top left of the new FMS.

7 Drag and drop the frame to the desired location.

    **Note:** You can only use one preview screen in an FMS template.

8 When you have completed your changes, select **File > Save**.

    The **Save** window appears.

9 Click **OK**.

**Using the Axes to Orient Images**

Each FMS has two planes (or axes) of symmetry, one vertical and one horizontal. The position of these axes affects the behavior of image frames in the FMS.

To move the axes in an FMS template, follow these steps:

1 In **CS Imaging**, click ![icon](image).

    The **Preferences** window appears.

2 Click ![icon](image).

3 Click **FMS Editor**.

    The **Manage FMS** window appears.

4 Click **Create** or **Modify**.

    The **FMS Editor** appears.

5 In the **FMS Editor**, click on the axis slider to reposition the axis:

    - Use the sliders (A+B) to position the axes of symmetry in the template.
• In the resulting FMS, if you move an image in a vertical frame in the FMS across the horizontal axis, the image is flipped about the horizontal axis.

• Moving the image across the vertical axis results in no flipped image.

• Moving an image in a horizontal frame across the vertical axis will flip the image about the vertical axis.

• Moving that image in the FMS across the horizontal axis results in no flipped image.

6 When you have completed your changes, click to save your template.

**Aligning a Frame**

You can align frames using the following methods:

• Display the grid to manually align individual frames.

• Switch on the following:
  
  • The Magnetic Grid feature so that individual frames will snap to points on the grid.

  • The Magnetic Frames feature so that frames will snap together.

  • Use the FMS Toolbox Align buttons to align a selection of frames. See “FMS Toolbox Buttons”.

To activate and align frames in an FMS template, follow these steps:

1 In CS Imaging, click . The Preferences window appears.

2 Click .

3 Click FMS Editor. The Manage FMS window appears.

4 Click Create or Modify. The FMS Editor appears.

<table>
<thead>
<tr>
<th>If you click...</th>
<th>You do the following...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the Grid.</td>
<td>Activate the Magnetic Grid. When you do this and reposition a frame, the corner of the selected frame closest to a grid point will snap to that position on the grid. This option works only when the Grid is active.</td>
</tr>
<tr>
<td>Activate the Magnetic Frame. When you do this and drag a frame alongside an existing frame, if the selected frame is close enough, it will be aligned automatically with the existing frame.</td>
<td></td>
</tr>
<tr>
<td>Align the left edge of selected frames.</td>
<td></td>
</tr>
</tbody>
</table>
When you have completed your changes, select **File > Save**.
The **Save** window appears.

6 Click **OK**.

**Assigning Default Tooth Numbers**
To assign a default tooth number, follow these steps:

1 In **CS Imaging**, click **preferences**.
The **Preferences** window appears.

2 Click **FMS Editor**.
The **Manage FMS** window appears.

3 Click **Create** or **Modify**.
The **FMS Editor** appears.

4 Select **View > Toolbox** to open the **FMS Toolbox**.
See “**FMS Toolbox Buttons**”.

5 In the **FMS Toolbox**, click the **Properties** tab.

6 Click the frame to which you want to assign tooth numbers.

   For bitewing images, you can specify which region of the mouth the bitewing image relates to.
   Select from the following options.

<table>
<thead>
<tr>
<th></th>
<th>Align the vertical centers of selected frames.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Align the right edge of selected frames.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>Align the top edge of selected frames.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>Align the bottom edge of selected frames.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>Align the horizontal centers of selected frames.</td>
</tr>
</tbody>
</table>

8 Select a drop-down list to assign up to six tooth numbers to that frame.

9 Repeat steps 7 and 8 for each frame.

10 When you have completed your changes, select **File > Save** to save your template.

RP  Select this option to designate the right premolar.
RM  Select this option to designate the right molar.
LP  Select this option to designate the left premolar.
LM  Select this option to designate the left molar.
The **Save** window appears.

11. **Click OK.**

### Assigning or Modifying Acquisition Order in an FMS Template

To assign or modify the acquisition order in an FMS template, follow these steps:

1. **In CS Imaging**, click **.**
   
   The **Preferences** window appears.

2. **Click .**

3. **Click **FMS Editor**.**
   
   The **Manage FMS** window appears.

4. **Select the FMS template whose acquisition order you want to modify and do one of the following:**
   
   - To modify a custom FMS template, select the custom template you want to modify and click **Modify**.
   - To create a custom template of a predefined FMS template, select the predefined template from the list and click **Copy > OK > Modify**.

5. **In the **FMS Editor**,** click **.**
   
   The current acquisition order of the FMS appears.

6. **Click each frame in the order you want to acquire the series.**

7. **Select **File > Save As**.**
   
   The **Save** window appears.

8. **Enter a file name that helps to identify the template. Include the extension **FMT** at the end of the file name.**

9. **Click **OK**.**

### Deleting an FMS Template

To delete an FMS template, follow these steps:

1. **In CS Imaging**, click **.**
   
   The **Preferences** window appears.

2. **Click .**

3. **Click **FMS Editor**.**
   
   The **Manage FMS** window appears.

---

**Note:** You cannot modify the acquisition order in a predefined FMS template; however, you can create a custom FMS template based on a copy of the predefined template whose order you can modify. See “Creating a Template in the FMS Editor.”
4 Select the template you want to delete and click **Delete**.

5 Click **Yes** to confirm that you want to delete the selected template.
8 General Imaging Functions

This chapter explains functions and concepts that you can apply to one or more of the following areas in CS Imaging:

- Dashboard
- Patient Browser
- Image Viewing Workspace
- Darkroom mode

CS Imaging provides icons and toolbars to capture, review, and analyze images, and can have the following characteristics. CS Imaging also uses tool tips, which are short descriptions of toolbar icons displayed in a small text box when you hold the mouse pointer over an icon.

Locating an Image File

If permitted by the “Service Preferences”, you can use the Localize option to see where an image is saved on the computer.

To locate an image file on your computer, right-click on an empty space and select Localize image from the shortcut menu.

Note: You can also access the Localize image option in the Image Information window. See “Displaying the Image Information Window”.

Important: Do not manually move images from one location to another using this option. It can cause serious problems with the data.

The folder containing the image on your computer appears.
Locating a Patient Directory

If permitted by the “Service Preferences”, you can use the Localize option to see where a directory is saved on the computer.

To locate a Patient Directory on your computer, right-click on an image and select Localize image from the shortcut menu.

Note: You can also access the Localize Patient Directory option in the Image Information window. See “Displaying the Image Information Window”.

Important: Do not manually move images from one location to another using this option. It can cause serious problems with the data.

The folder containing the image on your computer appears.

Displaying the Image Information Window

To display the Image Information window, do one of the following:

- In the Patient Browser or Dashboard, right-click on an image and select Show Information Window.
- In the Image Viewing Workspace or Darkroom mode:
  - Right-click on the image and select Show Information Window.
  - In the title bar of the image, click (Image Viewing Workspace) or (Darkroom mode).

The Image Information window appears.

In the Image Information window you can do the following:

- Display the DICOM tags for the image.
- View information for the selected image.
- Add a comment for the image. See “Adding a Comment to an Image”.

98
- Locate the image file on your computer. See “Locating an Image File”.
- Delete the image (If permitted in the “Service Preferences”)

The Image Information window offers the following tabs.

<table>
<thead>
<tr>
<th>General</th>
<th>This tab summarizes key data about the image, including the dosimeter reading where applicable.</th>
</tr>
</thead>
<tbody>
<tr>
<td>DICOM</td>
<td>This tab displays detailed image attributes sorted by DICOM tag.</td>
</tr>
</tbody>
</table>

**Printing Images**

WARNING: Printed image sizes vary according to the selected Film Composer template. Do not take measurements from a printed page.

You can print images using the following methods:

- Print an individual image or FMS. See “Printing 2D and FMS Images”.
- Print a snapshot of your Image Viewing Workspace. See “Printing a Snapshot of the Image Viewing Workspace”.

**Printing 2D and FMS Images**

**Printing a Single Image**

To print a 2D or FMS image, follow these steps:

1. Click to select the 2D image or FMS. The image appears with a blue frame around it.
2. Right-click the item and click Print.

**Tip:** You can also print in the following ways:

- In the Patient Browser or Dashboard, from the Export icon group, select.
- In the Image Viewing Workspace or Darkroom mode, in the toolbar, select in the Print icon group.

The Film Composer window appears.

3. Use Film Composer to configure your final print output. See “Using Film Composer”.

**Printing a Collection of 2D and FMS Images**

To print a selection of 2D or FMS images, follow these steps:

1. Press Ctrl + click to select images.
2. Do one of the following:
In the **Patient Browser** or **Dashboard**, from the **Export** icon group, select 📷.

**Tip:** In the **Patient Browser** or **Dashboard**, right-click one of the selected items and click **Print**.

- In the **Image Viewing Workspace**, in the 📷 toolbar, select 📷 in the **Print** icon group.

The **Film Composer** window appears.

3 Use **Film Composer** to configure your final print output. See “Using Film Composer”.

### Printing a Snapshot of the Image Viewing Workspace

To print a snapshot of all of the images in the **Image Viewing Workspace**, follow these steps:

1 In the 📷 **Share** toolbar, in the **Export** icon group, select 📷.

   The **Film Composer** window appears.

2 Use **Film Composer** to configure your final print output. See “Using Film Composer”.

### Using Film Composer

**Film Composer** is a separate component from **CS Imaging** and needs to be installed for you to access the print templates. **Film Composer** enables you to configure your print output. It automatically starts up when you print one or more images.

**Film Composer** templates constrain images within placement frames as either “Best Fit” or 1:1. Therefore the dimensions of a printed image can vary depending on the template used.

For more information on using **Film Composer**, see the **Film Composer** online help.

### Importing and Exporting Images

**CS Imaging** supports methods of image import and export such as:

- Drag and Drop, where individual images are exported as JPEG files.
- Right-click menu options
- Icons in toolbars

Icons for importing and exporting images can be found:

- In the **Patient Browser** or **Dashboard**, in the **Import** and **Export** icon groups.
- In the **Image Viewing Workspace** or **Darkroom** mode, in the **Import** and **Export** icon groups in the 📷 **Share** toolbar.
The triangle at the lower corner of an icon indicates that it is a member of an icon group. See “Using Icon Groups”.

**Importing Images**

After you have created a Patient Card, you need to either acquire images or import existing images associated with the patient. To acquire images, use the Image Acquisition toolbar. See “Acquiring an Image Using the Acquisition Toolbar”.

Icons for importing images are available:

- In the Patient Browser or Dashboard, in the Import icon group.

- In the Image Viewing Workspace or Darkroom mode, in the Share toolbar.

**Prerequisite:**

- If you are in the Patient Browser standalone mode, select a patient in the Patient List. All image thumbnails for the selected patient are displayed in the Patient History.

- From your DPMS, launch CS Imaging.

  The current patient’s name appears in the title bar in CS Imaging.

To import images, follow these steps:

1. From the Import icon group, select .

   A File Import window appears.

2. In the File Import window, browse to the folder that contains the images that you want to import.

3. Select the images that you want to import, and click Open or OK.

   The file or files you selected are imported and appear in the Patient History.

**Importing DICOM Images**

You can import images from removable media such as a flash drive or DVD if they are stored with a DICOMDIR file structure.

Icons for importing images are available:

- In the Patient Browser or Dashboard, in the Import icon group.

- In the Image Viewing Workspace or Darkroom mode, in the Share toolbar.

**Prerequisite:**

Note: The import of a large number of images can take a few minutes. Wait until all the images you have selected appear in the Patient History.
- If you are in the **Patient Browser** standalone mode, select a patient in the **Patient List**. All image thumbnails for the selected patient are displayed in the **Patient History**.

- From your DPMS, launch **CS Imaging**.
  The current patient's name appears in the title bar in **CS Imaging**.

To import a DICOMDIR, follow these steps:

1. From the **Import** icon group, select ![Import Icon](image). The **Open** window appears.

2. In the **Import** dialog box, select the DICOMDIR file you want to import and click **Open**. A DICOMDIR viewing window appears, displaying the contents of the DICOMDIR file.

3. In the **Open** window, browse to the folder that contains the images you want to import.

4. Select the images that you want to import and click **Open** or **OK**. The file(s) you selected are imported and appear in the **Patient History**.

   ![DICOMDIR Viewing Window](image)

   - **A** Name of the **Patient Card** into which you are importing images.
   - **B** Patient name in the DICOMDIR file.
   - **C** Image thumbnails for the selected patient name (**B**) in the DICOMDIR file.
   - **D** Import button (grayed out until you select an image thumbnail (**C**))

   __Important:__ Make sure you are associating the imported images with the correct patient.

   When you start the import, you will be prompted to confirm that you want to import images into the specific patient’s file.

5. To continue with the import, click **OK**.

**Exporting Images**

You can export images to a folder on your computer or network, or send them in an email to another email address.

Icons for exporting images are available:

- In the **Patient Browser** or **Dashboard**, in the **Export** icon group.
In the Image Viewing Workspace or Darkroom mode, in the Export icon group in the Share toolbar.

**Exporting Images to a Folder or an Email**

**Prerequisite:**

- If you are in the Patient Browser standalone mode, select a patient in the Patient List. All image thumbnails for the selected patient are displayed in the Patient History.
- From your DPMS, launch CS Imaging.

The current patient’s name appears in the title bar in CS Imaging.

To export images, follow these steps:

1. Press Ctrl + click to select the images that you want to export.
2. Do one of the following:
   - In the Patient Browser or Dashboard in the Export icon group:
     - To send the images in an email, select . The email export window appears.
     - To save the image in a folder, select . In the Save As window, for the Destination Folder, click  to browse to a folder.
   - In the Image Viewing Workspace or Darkroom mode, in the Share toolbar:
     - To send the image in an email, click . The email export window appears.
     - To save the image in a folder, select . In the Save As window, for the Destination Folder, click  to browse to a folder.
3. Select from the following drop-down lists based on the format type below:
104

- **Image type**

<table>
<thead>
<tr>
<th>Keep current format</th>
<th>CS Imaging file format with all processing information preserved. Important: Files saved in this format can only be used in CS Imaging version 8. If you are going to export this to people who do not have access to CS Imaging version 8, we recommend that you select another image type.</th>
</tr>
</thead>
<tbody>
<tr>
<td>For Presentation</td>
<td>A read-only format that can be used in other DICOM-compliant applications.</td>
</tr>
<tr>
<td>BMP, JPEG, TIFF, PNG</td>
<td>Standard graphics formats. Important: These formats do not provide accurate measurement capability and should not be used for diagnostic purposes.</td>
</tr>
</tbody>
</table>

- **Model type**

<table>
<thead>
<tr>
<th>Keep current format</th>
<th>CS Imaging file format with all processing information preserved. Important: Files saved in this format can only be used in CS Imaging version 8. If you are going to export this to people who do not have access to CS Imaging version 8, we recommend that you select another image type.</th>
</tr>
</thead>
<tbody>
<tr>
<td>STL, PLY</td>
<td>Standard 3D formats.</td>
</tr>
</tbody>
</table>

4 If you are in the **Save As** window, you can also select one or more of the following options.

- **Compress items**

  In the folder you select, a zip file is created that contains all the exported image files. You need to specify a name for the zip file.

- **Include drawings and annotations**

  Select to save the image with any drawings, measurements, or other overlaid elements visible. If the image is saved as DICOM, annotations are also saved. Annotations cannot be saved with BMP, JPEG, TIFF or PNG formats. **This does not apply to Model types.**

- **Show in folder**

  *(This option is not available when sending by email)* Select to open a Windows Explorer window that shows the contents of the folder in which your exported images were saved.

5 Do one of the following:

- If you are sending an image in an email, click **Send by e-mail items**. A new email is created in your default email application with the exported image or images attached to the email.

- If you are saving to a folder, click **Save items**.

**Note:** This button is grayed out until you specify an export folder.
Exporting DICOMDIR
You can export DICOM-formatted images to a portable media, for example a flash drive, memory card, DVD, and so on, outside of a DICOM server.

**Note:** The folder to which you export DICOM-formatted images must be empty.

Icons for exporting images are available:

- In the Patient Browser or Dashboard, in the Export icon group.
- In the Image Viewing Workspace or Darkroom mode, in the Export icon group in the Share toolbar.

**Prerequisite:**

- If you are in the Patient Browser standalone mode, select a patient in the Patient List. All image thumbnails for the selected patient are displayed in the Patient History.
- From your DPMS, launch CS Imaging.

The current patient's name appears in the title bar in CS Imaging.

To export a DICOMDIR, follow these steps:

1. Press Ctrl + click to select the images that you want to export.

2. From the Export icon group, select.

   The DICOMDIR export window appears.

3. In the Destination Folder field, do one of the following:
   - Enter the full file path of the folder to which you want to export the images.
• Click to browse to a folder.  

  Note: The folder you select must be empty.

4 To display the contents of the folder to which exported data has was saved, select **Show in folder**.

5 Click **Export**.

  Note: This button is grayed out until you specify an export folder.

**Exporting 3D Images Using the Volume Converter**

You can use the **Volume Converter** to export the 3D volume in a different format.

  Note: To export images using the **Volume Converter**, you need to have **CS 3D Imaging** installed on your computer.

To export a volume, follow these steps:

1. Select the volume.
2. Right-click on it and select **Convert To**.

   The **Volume Converter** window appears.

   For information on using the options available in this window, consult the **CS 3D Imaging User Guide**.

**Using Drag and Drop to Import and Export Images**

In addition to dedicated import and export functions, drag and drop is a quick way to copy images into and out of **CS Imaging**. **Drag and drop** is a general term that describes a method of copying items between two open software applications.

You can use drag and drop to do the following:

- Import images from a folder. See “Importing images using Drag and Drop”.
- Export images as JPEG files to a folder. See “Exporting Images using Drag and Drop”.
- Add images to Microsoft Office documents.
- Attach images to emails.

To use drag and drop, make sure the source and destination applications are open and resize them so they are both clearly visible on your desktop, then click an item, for example an image file in **CS Imaging**, and drag it over the destination application window.

If the destination application supports drag and drop, then when you release the mouse button, the image is dropped into that application window as a JPEG image.
Importing images using Drag and Drop

You can drag and drop images to import them into CS Imaging in one of the following file formats:

- DICOM
- BMP
- JPEG
- TIFF
- PNG
- STL
- PLY

You can also drag and drop other supported file formats into the Patient History, for example, Microsoft Office documents and text files. When you open one of these documents in the Patient History, the document opens in the relevant software application.

To drag and drop images into CS Imaging, follow these steps:

1. Launch Windows Explorer and open the folder that contains the image you want to import.
2. Make sure the Windows Explorer and CS Imaging windows are visible on your desktop by resizing them as required.
3. In Windows Explorer, click on an image file, hold the mouse button down and drag the mouse pointer over the Patient History (Patient Browser and Dashboard) or Image Gallery (Image Viewing Workspace and Darkroom mode) in CS Imaging.

   The mouse pointer changes to ☛ to show that you are about to copy something.
4. Release to drop the image.

Exporting Images using Drag and Drop

You drag and drop images from the Patient History (Patient Browser and Dashboard) or Image Gallery (Image Viewing Workspace and Darkroom mode) to a Microsoft application, like Word.

Important: When you drag and drop an image, it is converted to a JPEG file in the destination application.

If you need to export images with more export options than this, see “Exporting Images”

Note: During a drag and drop operation, if the mouse pointer changes to ☐ it means the application into which you are trying to drop the image cannot process image files in this way.

To export an image, follow these steps:

1. In the Patient History or Image Viewing Workspace, do one of the following:
   - To export to a Microsoft Office document, click on the image you want to copy and drag it towards the open Microsoft Office application.
To attach an image to an email, open your email application and create a new email. In the Patient History or Image Viewing Workspace, click on the image you want to copy and drag it towards the open email.

**Note:**
- If the email application supports drag and drop, the image is attached to your email as a JPEG attachment.
- This method does not work in web-based email applications.

To export an image to a folder on your computer, open Windows Explorer and display the destination folder. In the Patient History or Image Viewing Workspace, click on the image you want to export and drag it towards the open Windows Explorer window.

**Note:** The JPEG filename for the image file is the internal filename used by CS Imaging.

Do not let go of the mouse button until you are ready to drop the image into your document. As you drag the image, the mouse pointer changes to .

2. When the mouse pointer is over the destination document, email or folder, let go of the mouse button.

The selected image is dropped in the destination as a JPEG file.
Using the Radiological Log

The radiological log records patient and exposure data for all images acquired with CS Imaging, including the calculated dose received by the patient for each X-ray image. The Radiological log must be activated in the Preferences window before it can be used. See “Setting Preferences in CS Imaging”.

Below you’ll find the information stored in the Radiological log. See “Saving Images in the Image Viewing Workspace or Darkroom Mode” on page 45.

Information Recorded in the Radiological Log

- Acquisition date
- Patient name
- Date of birth
- Pregnancy of the patient
- Image type (intraoral, panoramic, cephalometric)
- Date of the last X-ray image taken
- Name of the acquisition system
- Treatment information
- KV setting of the acquired image
- mA setting of the acquired image
- Exposure time in ms of the acquired image
- Calculated dose for the acquired image

There are 2 cases:

**Dose information (present in the image)**

Dosage is calculated automatically when using Carestream generators with the following image types:

- Cephalometric
- Panoramic
- 3D (Dose is read-only)

**Acquisition data (image does not contain dose)**

For intra-oral image, the acquisition data needs to be entered to add to the radiological log. The software requests additional information for the log. When this data is not provided, a reminder window is displayed, prompting you to supply this data. You cannot exit this window until the necessary information has been entered.
Note: For intraoral generators, you must calculate dosage manually.
9 Setting Preferences in CS Imaging

The Preferences window, accessed by clicking on the icon, enables you to configure the following sets of CS Imaging preferences.

- “General Preferences”
- “Imaging Preferences”
- “3D View Preferences”
- “Save Preferences”
- “Image Processing Preferences”:
  - “RVG Processing Preferences”
  - “Panoramic Image Processing Preferences”
  - “Cephalometric Image Processing Preferences”
  - “CR Intraoral Image Processing Preferences”
  - “CR Panoramic Image Processing Preferences”
  - “CR Cephalometric Image Processing Preferences”
- “Print Preferences”
- “Template Preferences”
- “Radiological Log Preferences”
- “Service Preferences”

Important: While the Preferences window is open, you cannot perform other tasks in the software. You must first exit by clicking Cancel or OK.

When you have finished configuring a set of preferences, you have the following options:

- Click on another preferences icon and continue making changes. Your changes are retained but not yet saved.
- Save your changes and close the Preferences window by clicking OK.
- Cancel all your unsaved changes and close the preferences window by clicking Cancel.
General Preferences

To set the **CS Imaging General** preferences, follow these steps:

1. In System icons, click ⚙. The **Preferences** window appears.

2. Click ⚙.

3. Configure the following settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>From the drop-down list, select the language used in the software.</td>
</tr>
<tr>
<td>Help language</td>
<td>From the drop-down list, select the language for the information that appears when you click 🟢 in <strong>CS Imaging</strong>.</td>
</tr>
<tr>
<td>Name of practitioner</td>
<td>Click 📜 alongside the text field to enter practitioner name details.</td>
</tr>
<tr>
<td>Station name</td>
<td>Enter a workstation name.</td>
</tr>
<tr>
<td>Department name</td>
<td>Enter the name of your department.</td>
</tr>
<tr>
<td>Institution name</td>
<td>Click 📚 to select the name of your institution.</td>
</tr>
<tr>
<td>Practice logo</td>
<td>Click on the image frame to browse the computer for an image file of your practice’s logo. This logo will appear on your printed images.</td>
</tr>
</tbody>
</table>

4. Click **OK** to close the window and save your changes.
Imaging Preferences

These preferences enable you to set parameters that control how images appear on the screen and what you see when the software starts up.

To configure the Imaging preferences, follow these steps:

1. In System icons, click 
   The Preferences window appears.
2. Click .
3. Configure the following settings.

<table>
<thead>
<tr>
<th>Image overlay color</th>
<th>Select the color of text information overlays for your images.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tooth numbering system</td>
<td>Select either ADA (American) or FDI (European).</td>
</tr>
<tr>
<td>Inside looking out</td>
<td>Select to see all x-rays from inside the patient’s mouth looking out. The left side of the image on the screen corresponds to the patient’s left side. If this option is not selected, the left side of the image on the screen corresponds to the patient’s right side. The molars on the right side of the patient’s head appear on the left side of the screen.</td>
</tr>
<tr>
<td>Blue filter</td>
<td>Select to apply a blue tint to all images, giving the images the appearance of traditional x-ray images.</td>
</tr>
<tr>
<td>Monitor test pattern</td>
<td>Select to see a test pattern the first time you launch CS Imaging on a given day. Use the test pattern to calibrate your computer monitor to properly render radiological images.</td>
</tr>
<tr>
<td>Display brand logo on images</td>
<td>Select to show the equipment brand logo when you view an image in the Image Viewing Workspace or Darkroom mode.</td>
</tr>
<tr>
<td>Display dosimeter on newly acquired images</td>
<td>Select to see, when available, a dosimeter reading on the newly acquired images. Note: Once the new image has been saved, the dosimeter reading is only displayed on the Image Information window. See “Displaying the Image Information Window”.</td>
</tr>
<tr>
<td>Display calibration indicator on images</td>
<td>Select to see the calibration image on images. See “System-Generated Image Overlays”.</td>
</tr>
<tr>
<td>Reset all warning messages</td>
<td>Select this button to reset all warning message settings.</td>
</tr>
<tr>
<td>Choose default program</td>
<td>For CS Model, CS Restore, CAD and 3D files, select a default program to open these files from the drop-down lists.</td>
</tr>
</tbody>
</table>

4. Click OK to close the window and save your changes.
3D View Preferences

In the 3D View preferences, you can optimize performance by configuring the following settings:

- Set 3D rendering prioritization.
- Allow shading.
- Select a rendering technique.

To set the 3D preferences, follow these steps:

1. In System icons, click 

   The Preferences window appears.

2. Click 

3. Configure the following settings.

<table>
<thead>
<tr>
<th>To set the prioritization of the software's performance</th>
<th>Select a Rendering prioritization:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Rendering Speed for high speed.</td>
</tr>
<tr>
<td></td>
<td>• Speed/Quality balance for medium speed.</td>
</tr>
<tr>
<td></td>
<td>• Rendering Quality for low speed, but better images.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To activate or deactivate shading in the 3D View Screen</th>
<th>Click Shading.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><em>Note:</em> To get the best image results, make sure Shading is selected when you take screenshots.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To select a 3D rendering option that matches your computer performance</th>
<th>Select one of the following from the Desired rendering technique drop-down list:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Enhanced hardware-accelerated rendering</td>
</tr>
<tr>
<td></td>
<td>Software rendering</td>
</tr>
</tbody>
</table>

4. Click Apply, then OK to close the window and save your changes.

*Note:* Changes will be applied once you have restarted the application.
Save Preferences

To set the Save preferences, follow these steps:

1. In System icons, click 🛠️.
   The Preferences window appears.

2. Click ☑️.

3. Configure the following settings.

<table>
<thead>
<tr>
<th>Automatically save image modifications</th>
<th>Select to have changes and revisions to images automatically saved while you are working on the images.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically save new images</td>
<td>Select to have new images saved without manual authorization. This option applies only to newly acquired images.</td>
</tr>
<tr>
<td>Automatically open default analysis</td>
<td>Select to have any images that were viewing when you last closed a patient record should automatically appear in the Image Viewing Workspace for the same patient record. If this option is not selected, no patient images appear when you open the Image Viewing Workspace.</td>
</tr>
<tr>
<td>Automatically save a copy of images</td>
<td>Select to have a copy made for any images created, modified, or imported for a patient as a sub-folder within the patient image directory. You can also select the file format for the image copies.</td>
</tr>
</tbody>
</table>

Click OK to close the window and save your changes.

Image Processing Preferences

Processing preferences for images are displayed on these separate tabs:

- “RVG Processing Preferences”
- “Panoramic Image Processing Preferences"
- “Cephalometric Image Processing Preferences”
- “CR Intraoral Image Processing Preferences”
- “CR Panoramic Imagine Processing Preferences”
- “CR Cephalometric Image Processing Preferences”
**RVG Processing Preferences**

In the **Processing** Preferences, you can set the **RVG** processing preferences.

### Acquisition Preferences

| Synchro-link installed | Select to install a CCX synchronization link and timer. The acquisition icon is permanently displayed in green when the synchronization timer is turned on, and exposures can be made at any time. When using the synchronization link, follow the appropriate steps for your specific hardware:  
- When using RVG5 sensors, the CCX link plugs in directly to the RVG USB box or the RVG PCI card in the computer.  
- When using RVG 5x00 or RVG 6x00 sensors, the CCX link connects to one of the USB ports of the computer. A specific CCX device must be installed between the x-ray generator and the computer to convert the link to USB format.  
Once the CCX hardware is installed and the option is selected, the following changes will occur in the **CS Imaging** software:  
- The RVG x-ray icon is set to green.  
- RVG acquisition is launched by acquiring x-rays. The image window on the computer.  
- Click **RVG5x00/6x00 sensor** to change the orientation of the captured image, unless you are using FMS. Clicking this button also changes the active sensor. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Display button to manually connect RVG 6500 sensors</td>
<td>When you select this option, an additional button is available that allows you to connect the RVG 6500 sensor to the computer.</td>
</tr>
</tbody>
</table>
| RVG5 | From the drop-down list, select one of the following options:  
**Hi Resolution (HR):** This is the default setting for the RVG5 sensor. It is used to acquire images with the maximum detail.  
**Hi Sensitivity (HS):** This setting acquires images with less detail, but requires less radiation and is therefore recommended for pregnant women or young children. |
| Network shared folder path for RVG synchronization files | Configure the location used to store RVG synchronization files. Click to browse and select a different location. |

### Acquisition Settings

| Sharpness filter | Select to have image details sharpened with increased contrast. **Note:** The Sharpness filter option can be disabled on an image if you apply a combination of filters. See "Using the Histogram". |
| Anatomical mode | From the drop-down list, select one of the following options:  
**Perio:** Optimizes the display of periodontal tissues.  
**Endo:** Optimizes contrast values to display canals and roots.  
**Dentin-to-enamel junction:** Strongly accentuates contrast values in the more radio-opaque tissues at the crown, the amelo-dentinal junction, and the roots. This mode provides a clear display of any caries or lesions. |
Image Processing Preferences

The options available here will vary according to the RVG acquisition hardware connected to your system. If you previously used a Carestream Imaging software as your image analysis tool, these settings will automatically be retained in CS Imaging.

| RVG 5100/6100 | From the drop-down list, select one of the following options:  
|               | • 6500 contrast  
|               | • Optimized contrast and sharpness  
|               | • Higher Sharpness  
|               | These options must be the same as the processing configuration of your RVG sensor. |
| RVG 5200/6500 | From the drop-down list, select the applicable sharpness filter strength. |
| RVG 6200 Favorite selection and customization | Click to configure and select filter favorites in CS Adapt Library. |

You can also adjust contrast settings for RVG images post acquisition using the Image Processing tool in the Control Panel. See “Using the Image Processing Tool”.

Panoramic Image Processing Preferences

In the Processing tab, you can configure default settings for Panoramic image acquisitions instead of applying filters to individual images.

| Sharpness filter | Select to have image details sharpened with increased contrast.  
| Sharpness filter strength | From the drop-down list, select a Sharpness filter strength.  
| You use this option if you work with Eathernet panoramic images. |
| Contrast mode | From the drop-down list, select one of the following options:  
| • Linear: Displays images with softer tones (no edgy contrasts).  
| • Optimized contrast: Optimizes contrast and sharpens up image detail.  
| • Strong contrast: Applies a strong optimization contrast. |
| Favorite selection and customization | Click to configure and select filter favorites in CS Adapt Library. |

Cephalometric Image Processing Preferences

In the Processing tab, you can to configure default settings for Cephalometric image acquisitions instead of applying filters to individual images.
# Acquisition Settings

<table>
<thead>
<tr>
<th>Contrast mode</th>
<th>From the drop-down list, select one of the following options:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Linear</strong>: Displays images without image enhancing filters.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Optimized contrast</strong>: Optimizes contrast and sharpens up image detail.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Bone density</strong>: Optimizes contrast for analyzing bone density.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Edges</strong>: Optimizes contrast for identifying the edges.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Bone density filter strength</th>
<th>For some panoramic acquisition devices, you need to select a bone density filter strength.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Edges filter strength</th>
<th>For some panoramic acquisition devices, you need to select an edge filter strength.</th>
</tr>
</thead>
</table>

**Favorite selection and customization**

Click ![button](image) to configure and select filter favorites in CS Adapt Library.

---

**Note:** To launch the cephalometric Tracings Editor, go to the Templates preferences tab. See “Template Preferences”.

---

## Ceph Image True Size Calibration

<table>
<thead>
<tr>
<th>Magnification Factor</th>
<th>Specify a default zoom factor for printing a cephalometric image. Enter 1 for true size.</th>
</tr>
</thead>
</table>

---

## CR Intraoral Image Processing Preferences

In the Processing preferences, you can configure **CR Intraoral** acquisition defaults.

<table>
<thead>
<tr>
<th>Sharpness filter</th>
<th>Select to have image details sharpened with increased contrast.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Note:</strong> The Sharpness filter option can be disabled on an image if you apply a combination of filters. See “Using the Histogram”.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Anatomical mode</th>
<th>From the drop-down list, select one of the following options:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Perio</strong>: Optimizes the display of periodontal tissues, and to search for information contained in radio-transparent tissues. The digital image becomes generally whiter, with only the periodontal area displayed effectively.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Endo</strong>: Optimizes the contrast values over the entire gray scale range to enhance contrast at the canals and roots. It also provides good overall contrast throughout the image.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Dentin-to-enamel junction</strong>: Strongly accentuates contrast values in the radio-opaque tissues at the crown, the amelo-dentinal junction, and the roots. This mode provides a clear display of any caries or lesions.</td>
</tr>
</tbody>
</table>
### CR Panoramic Imagine Processing Preferences

In the **Processing** preferences, you can configure **CR Panoramic** acquisition defaults.

| Sharpness filter          | Select to have image details sharpened with increased contrast.  
<table>
<thead>
<tr>
<th></th>
<th><strong>Note:</strong> The Sharpness filter option can be disabled on an image if you apply a combination of filters. See “Using the Histogram”.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contrast mode</strong></td>
<td>From the drop-down list, select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Linear:</strong> Displays images without image enhancing filters.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Optimized contrast:</strong> Optimizes contrast and sharpens up image detail.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Strong contrast:</strong> Increases edge sharpness in the filter.</td>
</tr>
</tbody>
</table>

### CR Cephalometric Image Processing Preferences

In the **Processing** preferences, you can configure **CR Cephalometric** acquisition defaults.

| **Contrast mode**         | From the drop-down list, select one of the following options: |
|                          | - **Linear:** Displays images without image enhancing filters. |
|                          | - **Optimized contrast:** Optimizes contrast and sharpens up image detail. |
|                          | - **Bone density:** Optimizes contrast for analyzing bone density. |
|                          | - **Edges:** Optimizes contrast for identifying the edges. |
| **Bone density filter strength** | From the drop-down list, select the default contrast for analyzing bone density. |
| **Edges filter strength** | From the drop-down list, select the default edge enhancement strength for your cephalometric images. |
Print Preferences

To set the CS Imaging Print preferences, follow these steps:

1. In System icons, click 📋.
   The Preferences window appears.

2. Click ☑️.

3. Configure the following settings.

<table>
<thead>
<tr>
<th>Choose Print template</th>
<th>From the drop-down list, select the template that will be applied in Film Composer when you print images.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Note:</strong> Click ⚠️ to read an important template warning about de-selecting the default template.</td>
</tr>
<tr>
<td>Print page layout</td>
<td></td>
</tr>
<tr>
<td>Optimized print layout</td>
<td>Select to have the print layout automatically optimized by your CS Imaging software.</td>
</tr>
<tr>
<td>One image per page</td>
<td>Select to print each image on a separate page.</td>
</tr>
<tr>
<td>Print FMS</td>
<td></td>
</tr>
<tr>
<td>Print FMS and each intraoral image (multiple pages)</td>
<td>Select to print each FMS and its component images on separate pages.</td>
</tr>
<tr>
<td>Print FMS on one page</td>
<td>Select to print the FMS on one page.</td>
</tr>
<tr>
<td>Print background color</td>
<td>From the drop-down list, select the background color for printed pages (Black, White or Gray). The default is White.</td>
</tr>
</tbody>
</table>

4. Click OK to close the window and save your changes.
Template Preferences

To set the CS Imaging Template preferences, follow these steps:

1. In System icons, click ☰.
   The Preferences window appears.

2. Click ☰.

3. Configure the following settings.

<table>
<thead>
<tr>
<th>FMS templates path</th>
<th>Click ☰ to change the storage location for FMS template files.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FMS image proportion</strong></td>
<td>Select one of the following options to configure the default setting for how images are displayed within FMS templates:</td>
</tr>
<tr>
<td>- <strong>Stretch image to frame</strong></td>
<td>Stretches the image to fit the frame. This may give the appearance of distorted anatomy if a smaller sensor/CR plate is used to acquire an image in a frame intended for a larger sensor/CR plate.</td>
</tr>
<tr>
<td>- <strong>Relative size proportions</strong></td>
<td>Scales the image in proportion to the window size. This option displays the images acquired at the relative size of the sensor/CR plate. This might make an FMS appear smaller than it does when the Stretch image to frame option is selected.</td>
</tr>
<tr>
<td><strong>FMS Editor</strong></td>
<td>Click to open the FMS Editor, in which you can manage existing templates and create templates. See “Using FMS”.</td>
</tr>
<tr>
<td><strong>CEPH tracing templates path</strong></td>
<td>Click ☰ to change the storage location for cephalometric tracing template files.</td>
</tr>
<tr>
<td><strong>Tracings Editor</strong></td>
<td>Click to open the cephalometric Tracings Editor, in which you can customize automatic tracings and define your own cephalometric tracings templates. See “Using the Tracings Editor”.</td>
</tr>
<tr>
<td><strong>Custom presets path</strong></td>
<td>Click ☰ to change the storage location for custom preset files.</td>
</tr>
<tr>
<td><strong>Favorite presets path</strong></td>
<td>Click ☰ to change the storage location for favorite preset files.</td>
</tr>
</tbody>
</table>

4. Click OK to close the window and save your changes.
Radiological Log Preferences

To set the CS Imaging Radiological log preferences, follow these steps:

1. In System icons, click [Preferences].
   The Preferences window appears.

2. Click [Activate radiological log].

3. Configure the following settings.

<table>
<thead>
<tr>
<th><strong>Activate radiological log</strong></th>
<th>Select the check box to start logging radiological data.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Intra-oral generator</strong></td>
<td>Select the intra-oral generator from the drop-down list or create your own generator. In the adjacent fields, specify acquisition dosimetry values in Kilo Volts and Milli Amps.</td>
</tr>
<tr>
<td><strong>Panoramic generator</strong></td>
<td>Select the panoramic generator from the drop-down list or create your own generator. In the adjacent fields, specify acquisition dosimetry values in Kilo Volts and Milli Amps.</td>
</tr>
<tr>
<td><strong>Cephalometric generator</strong></td>
<td>Select the cephalometric generator from the drop-down list or create your own generator. In the adjacent fields, specify acquisition dosimetry values in Kilo Volts and Milli Amps.</td>
</tr>
<tr>
<td><strong>Path</strong></td>
<td>Specify the location of the radiological file. This can be a local folder or a shared folder.</td>
</tr>
<tr>
<td><strong>Export All Radiological Log</strong></td>
<td>Click to export the entire radiological log to a specified .csv file. The .csv file can then be opened for viewing in a spreadsheet such as Microsoft Excel.</td>
</tr>
</tbody>
</table>

4. Click [OK] to close the window and save your changes.
Service Preferences

To set the CS Imaging Service preferences, follow these steps:

1. In System icons, click 🛠.
   The Preferences window appears.

2. Click ⚙.

3. Enter an input service password.
   The Services are only for dentists and are protected by the following password that should not be shared with patients: **2748**.
   The General preferences appear.

4. Configure the following settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Localyze image</strong></td>
<td>Select so that you can locate images on your computer. See “Locating an Image File”.</td>
</tr>
<tr>
<td><strong>Display patient list at start-up</strong></td>
<td>Select to see the Patient List in the Patient Browser when you open the software in standalone mode. If this option is not selected, then the Patient List will be blank.</td>
</tr>
<tr>
<td><strong>Allow deletion of patient cards and images</strong></td>
<td>Select to allow patient cards and images to be deleted. See “Deleting a Patient Card”. Important: Patient cards and images are deleted permanently and cannot be retrieved, except by using a data recovery. See “Data Recovery”.</td>
</tr>
</tbody>
</table>

5. Click OK to close the window and save your changes.
10 Data Backups

To back up data means to regularly copy important data in a safe location as a precaution against unexpected computer failure.

During a recovery process, the backed up data is restored to specified locations on the repaired computer, so as to restore normal service as quickly as possible.

**Important:** You must regularly backup all your CS Imaging data. Contact your local support representative if you need technical assistance with this.

**Backing Up Your Data**

To back up your CS Imaging images and database, follow these steps:

1. Go to any computer within the CS Imaging community.
2. Click 📱 in the Windows system tray.
   The Monitor panel appears.
3. Select CSDM Lite, then Get configuration.
   The CSDM Lite archive root window.
4. Copy the archive root path to your backup media.

**Data Recovery**

In the event of an unexpected computer failure or malfunction, data recovery is the process of restoring the backed up data to specific locations on the repaired computer to restore normal service.

If you are faced with this situation, contact your local support representative for technical assistance with data recovery.

**Note:** If you cannot find an acquired image in the Patient History after a technical issue, you can try to recover the original image in one of the folders on your computer’s hard disk.
Configuring CSDM Lite

Important: This section is for advanced users only. For more information contact your technical representative.

Overview

CS Imaging manages your image database and patient list via CSDM lite. An application called Monitor allows you to check on the status of CSDM lite. You can also use Monitor to:

- Restart CSDM lite.
- Determine database folder location.
- Select a different database folder.

Opening Monitor and Checking CSDM Lite

To open Monitor, in the system tray on your computer desktop, click .

If this icon is not visible, click to reveal hidden icons.

The Monitor panel is displayed (it may be hidden behind other application windows):

When CSDM lite is running and functioning correctly, the status column in Monitor is displayed in green.

Restarting the CSDM Lite

To restart CSDM lite, follow these steps:

1. Click in the system tray to display the Monitor panel.
2. In the Monitor panel, click CSDM lite. A panel of buttons appears.
3. In the panel of buttons, click Restart. CSDM lite is stopped and restarted.

When it has restarted successfully, a message appears in the Monitor panel.
Determining Database Folder Location

To determine the current database folder location, follow these steps:

1. Click 📀 in the system tray to display the Monitor panel.
2. In the Monitor panel, click CSDM lite.
   
   A panel of buttons appears.

3. In the panel of buttons, click Get configuration.
   
   A message appears in the Monitor panel that gives the current location of the database folder.

Selecting a Different Database Folder

To select a different database folder, follow these steps:

1. Click 📀 in the system tray to display the Monitor panel.
2. In the Monitor panel, click CSDM lite.
   
   A panel of buttons appears.

3. In the panel of buttons, click Set configuration.
   
   The Select Folder dialog box appears.

4. In the Select Folder dialog box, browse to the folder on your computer that you want to use to locate your image database, and click the Select Folder button.
   
   Your system is reconfigured, and a message is displayed in the Monitor panel to confirm your folder selection.
11 Contact Information

Manufacturer's Address

Carestream Dental LLC
1765 The Exchange,
Atlanta, GA USA 30339

Factory

Trophy
4, Rue F. Pelloutier, Croissy-Beaubourg
77435 Marne la Vallée Cedex 2, France

Authorized Representatives

Authorized Representative in the European Community

TROPHY
4, Rue F. Pelloutier, Croissy-Beaubourg
77435 Marne-la-Vallée Cedex 2, France

Authorized Representative in Brazil

Representante no Brasil Carestream do Brasil Comércio e Servicos de Produtos Médicos Ltda
Rua Pequetita, 215 cjs.
31 E 32 Edifício Atrium VII - Vila Olimpia
São Paulo - Brazil
CEP (Zip code): 04552-060